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Welcome

Download

You can download a PDF version of the entire manual by clicking the 
PDF icon to the left. This PDF file was last updated on Nov 27, 2016.

You can also download individual pages in this manual in PDF or 
Microsoft Word formats. Click the Tools menu in the top right of any 
page.

Recently Updated

Test Mailbox Access
Oct 28, 2021 contributed by  • Jim Beveridge

Send to Exchange distribution list
Mar 14, 2021 contributed by  • Jim Beveridge

Outlook Passwords
Dec 27, 2020 contributed by  • Jim Beveridge

Create an Exchange Mailbox
Dec 27, 2020 contributed by  • Jim Beveridge

System Requirements
Dec 27, 2020 contributed by  • Jim Beveridge

Technique 2: Full Access privilege
Dec 27, 2020 contributed by  • Jim Beveridge

Search User's Guide
About

Epicenter Server is a  for Microsoft Windows from software product Connected 
 that allows Exchange administrators to distribute their Global Software

Address List to iPhone, iPad and Android devices.

You are reading the Epicenter Server User's Guide, which begins with a 
description of Epicenter Server and then goes into detail on configuring and 
using the software.

This guide is targeted at experienced Microsoft Exchange and Outlook 
administrators. You should be comfortable managing Outlook profiles and 
configuring Exchange permissions.

   

https://connectedsw.atlassian.net/wiki/display/~557058%3A5d14ede6-9065-4653-b976-a15e30d1c695
https://connectedsw.atlassian.net/wiki/display/~557058%3A5d14ede6-9065-4653-b976-a15e30d1c695
https://connectedsw.atlassian.net/wiki/display/~557058%3A5d14ede6-9065-4653-b976-a15e30d1c695
https://connectedsw.atlassian.net/wiki/display/~557058%3A5d14ede6-9065-4653-b976-a15e30d1c695
https://connectedsw.atlassian.net/wiki/display/~557058%3A5d14ede6-9065-4653-b976-a15e30d1c695
https://connectedsw.atlassian.net/wiki/display/~557058%3A5d14ede6-9065-4653-b976-a15e30d1c695
http://www.connectedsw.com/Overview/57261
http://www.connectedsw.com/
http://www.connectedsw.com/
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Product Description
Nov 20, 2020 contributed by  • Jim Beveridge

Send the Update
Feb 17, 2020 contributed by  • Jim Beveridge

Destination Folder page
Feb 17, 2020 contributed by  • Jim Beveridge

Quick Start
Feb 17, 2020 contributed by  • Jim Beveridge

Technique 1: Receive-As privilege
Feb 17, 2020 contributed by  • Jim Beveridge

Choose a Machine
Feb 17, 2020 contributed by  • Jim Beveridge

Contacts won't synchronize
Feb 17, 2020 contributed by  • Jim Beveridge

Create multiple tasks
Feb 17, 2020 contributed by  • Jim Beveridge

System Requirements
Jan 30, 2020 commented by Anonymous • 

https://connectedsw.atlassian.net/wiki/display/~557058%3A5d14ede6-9065-4653-b976-a15e30d1c695
https://connectedsw.atlassian.net/wiki/display/~557058%3A5d14ede6-9065-4653-b976-a15e30d1c695
https://connectedsw.atlassian.net/wiki/display/~557058%3A5d14ede6-9065-4653-b976-a15e30d1c695
https://connectedsw.atlassian.net/wiki/display/~557058%3A5d14ede6-9065-4653-b976-a15e30d1c695
https://connectedsw.atlassian.net/wiki/display/~557058%3A5d14ede6-9065-4653-b976-a15e30d1c695
https://connectedsw.atlassian.net/wiki/display/~557058%3A5d14ede6-9065-4653-b976-a15e30d1c695
https://connectedsw.atlassian.net/wiki/display/~557058%3A5d14ede6-9065-4653-b976-a15e30d1c695
https://connectedsw.atlassian.net/wiki/display/~557058%3A5d14ede6-9065-4653-b976-a15e30d1c695
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Quick Start

Epicenter Server Installation and Usage

Configure Exchange

1. Create a Mailbox

It is safest to give Epicenter Server its own mailbox ( ) If you are are on a domain with a dedicated Exchange Server, this why?
means that you'll also need to create an account for the mailbox.

2. Configure Permissions

If you are on a dedicated Exchange Server,  to the account running Epicenter Server.assign Receive-As permission

If you are on Office 365 or any other Hosted Exchange service, read the manual page about managing   mailboxes. Full Access
There are several considerations, so it's important to review the details. 

Install Software

1. Choose a Host

Epicenter should be installed on a computer or virtual machine that is always running. Epicenter requires minimal system resources 
and can be installed on anything from a small Windows virtual machine all the way up to the latest version of Windows Server. (tell 

)me more

2. Install Outlook

Epicenter Server requires Microsoft Outlook 2010 or later ( ). 64-bit Outlook is supported but not recommended due to stability why?
issues.

3. Configure Outlook Profile

Configure your Exchange profile in Outlook. If you are on a domain, you must create a profile for the mailbox for the account where 
Epicenter Server is running.

4. Run Outlook

You must run Outlook at least once to allow Outlook to finish configuring the profile and the mailbox. After this, it does not matter 
whether Outlook is running or not when Epicenter sends an update.

5. Test permissions

Permissions in Exchange Server can take a while to propagate. Test them by  to your profile adding one of the recipient mailboxes
and then opening that mailbox in Outlook. Epicenter Server can give strange and obscure error messages if permissions are not 
set properly, so testing is highly recommended.

6. Install Epicenter Server

Install Epicenter Server from the  installation file. You received a link to this file along with your EpicenterServerSetup.exe
license code or your . This information is not in your receipt.Eval Request

The section describes what you absolutely must do to configure Epicenter Server to distribute updates to users' mailboxes in Exchange. If
you read nothing else, read this page.

Do not install Epicenter Server on an Exchange Server. Epicenter's configuration can conflict with these servers and may 
render them unusable.

http://www.connectedsw.com/EvalEpicenter.php
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Send an Update

1. Create a Task

Tasks define the "who, what, where and when" for contacts you distribute ( .) Click the New button on the toolbar to tell me more
create a task

2. Send the Update

Once the task is created, click Send Now. Otherwise it won't run until the next scheduled update.

4. Wait for Sync

Your initial update can take up to an hour to synchronize with the smartphones. Once the initial update has been synchronized, 
subsequent changes typically appear in a few minutes. If you have trouble with synchronization you can see Contacts won't 

.synchronize

5. Log Out

Epicenter Server will run even when you aren't logged in. Because Epicenter's account is highly privileged, you should not leave it 
logged in when you are finished configuring Epicenter Server.

Customize Epicenter Server

Send to an Exchange Distribution List

Instead of entering all of your recipients into Epicenter Server, you can  and let Exchange use an Exchange distribution list
determine the recipients. This significantly cuts down administration time when new employees are hired.

Send Only Part of the GAL

You can configure Epicenter Server to send a selected part of the GAL as described in .Send a subset of the GAL

Create Multiple Tasks

It's possible to send different contacts to different recipients by creating multiple tasks. See .Create multiple tasks

Allow Users to Edit Contacts

You can give users the ability to edit certain fields such as comments and home phone number. See .Reserve User Properties
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Product Description

Epicenter Server allows organizations to update iPhone/iPad, Android, and Windows Mobile users with a copy of the corporate address list or 
any other list of contacts. Epicenter solves the problem of smartphones that can't sync with a public address book.

Most popular questions are answered in the .FAQ

Epicenter Server can be configured in any combination of these update methods:

1. Exchange mailbox updates

Epicenter copies the source address book into each user’s mailbox in Exchange and updates mailboxes as the source address book changes. 
Then Exchange automatically synchronizes changes wirelessly to the devices via ActiveSync. Changes appear in the default contacts application 
on the device.

This method requires Exchange Server (dedicated or hosted) and will work with any phone that supports ActiveSync.

See   for instructions.Configuration (Typical)

2. Public Folder updates

This option is used to keep a public folder up to date. It is generally not useful for syncing with mobile devices. Epicenter copies the source 
address book, typically all or part of the Exchange GAL, into a single Public Folder in Exchange.

See   for instructions.Public Folder updates

3. Email attachment updates

Epicenter sends out each update as an attachment to email. Users who receive that attachment double click it to update their local address book. 
This method is intended to update address books for POP3 users and is typically not used for updating smartphones.

See   for instructions.Attachment Updates for POP3/IMAP Users
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System Requirements

Server Requirements

Epicenter Server runs on a client workstation, not on the Exchange Server. Epicenter Server is typically run in a VM and has a minimal impact on 
system resources.

The system requirements for Epicenter Server are as follows:

Microsoft Windows Server 2008R2/2012R2, and Server 2016/2019. Windows Pro 7, 8.x, 10 are also supported. Both the 32-bit and the 64-bit 
versions of Windows are supported. UPDATE 5/30/2019: 64-bit Epicenter is not currently supported on Windows 10 nor Windows Server 2016
/2019.
Microsoft Outlook 2013/2016/2019/365, 32-bit and 64-bit. See   for more information. The "Click to Run" version of Outlook is Hosted Exchange
supported. On Windows 10 and Windows Server 2016, only 32-bit Outlook is supported.
20MB hard disk space.
Epicenter requires special permissions to open user mailboxes. See .Set Mailbox Permissions

To perform automatic wireless synchronization with smartphones, your infrastructure must include:

Exchange Server 2013/2016/2019 or Microsoft 365 (formerly Office 365).
Wireless connectivity from the smartphone to the synchronization server.
ActiveSync must be enabled on the Exchange Server.

Device Requirements

Epicenter supports all devices that can sync contacts through Exchange ActiveSync, including but not limited to:

Android version 4.2.2 or later, phones and tablets
iPhone/iPad with iOS version 7 or later
Windows Mobile/Windows Phone

Client Requirements

The system requirements for the Epicenter client are as follows:

Microsoft Windows 7/8/10. The “Home” versions of Windows are supported by the client.
Internet browser with internet connectivity
Microsoft Outlook 2013/2016/2019 32-bit. Outlook 64-bit is not supported.

 The client is only required for users who cannot sync wirelessly. Most installations will not use the client.
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Installation

Create an Exchange Mailbox

It is safest to create a dedicated mailbox for Epicenter Server. Epicenter will have direct access to many (or all) mailboxes on your Exchange 
Server. If you were to use your personal mailbox for Epicenter, then anyone walking up to your computer could open any mailbox used by 
Epicenter without a password. Worse, if your laptop were stolen, the thief may also be able to access those Exchange accounts.

Dedicated Exchange environments

If you are on a domain with a dedicated Exchange Server, you'll need to create a new account for Epicenter and create a mailbox. Do not reuse 
any of the Administrator accounts because they are specifically denied the required rights.

Hosted Exchange environments

If you use Hosted Exchange, creating a dedicated mailbox for Epicenter is strongly recommended to prevent security holes, as described above. 
The procedure for doing this will depend on your hosting provider.

Next: Set Mailbox Permissions

Set Mailbox Permissions

 

In order to update mailboxes, Epicenter Server requires permission to access all Exchange mailboxes that will be updated by Epicenter.

The techniques for configuring these permissions is described below. These permissions have significant security ramifications that are 
described under  in .Choose a Host Install Epicenter Server

Dedicated Exchange Server users

Start with .Technique 1: Receive-As privilege

Hosted Exchange users

Start with .Technique 2: Full Access privilege

High security installations

Use , as should other administrators where Technique 1 and Technique 2 are not feasible.Technique 3: Folder permissions

 

Technique 1: Receive-As privilege

Using the Receive-As privilege is only suitable for a dedicated Exchange Server environment. This technique is the easiest to configure, but 
requires administrative access to the Exchange Server. See  if you use a Hosted Exchange service, such as Technique 2: Full Access privilege
Office 365.

This configuration gives Epicenter Server access to all mailboxes and so may not be appropriate in some highly secure environments.

The steps below are only necessary if you will be distributing contacts to each user's Exchange mailbox. This is the most common 
configuration.

Important
Give Epicenter Server a dedicated Exchange mailbox. Do not configure your own account for unlimited access. See Create an Exchange 

.Mailbox
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Connected Software does not provide free technical support for Exchange administration tasks such as configuring permissions on your 
Exchange Server.

Setting Permissions on Exchange

To enable access to  all mailboxes for Exchange Server, go to the article titled :How to Allow Mailbox Access

http://technet.microsoft.com/en-us/library/aa996343.aspx

Look for the section that describes how to grant the Receive-As permission to the mailbox database. You do  need to grant the necessary not
permission on a per-mailbox basis.

Here is an example:

Start the Exchange Management Shell (not the Console.)
Enter this command, :all on one line

[PS] C:\> get-mailboxdatabase | add-adpermission -user "JForrester" -extendedrights receive-as

Technique 2: Full Access privilege

This page describes how to connect Epicenter to mailboxes from other users when using Microsoft 365 or other Hosted Exchange providers. The 
exact steps are documented below.

Microsoft 365 (formerly Office 365)
Using Epicenter Server with Microsoft 365 has several requirements:

Epicenter Server must be able to connect to the Exchange mailbox without having to enter a username and password. See Outlook 
 for more information.Passwords

Configure Epicenter Server to use "Full Access" Exchange Privileges in the   |   window.Tools Exchange Privileges
Configure Exchange to give the Epicenter account Full Access privileges, as described below. Make sure you disable AutoMap.
IMPORTANT: If you have Modern Authentication enabled in Microsoft 365, you MUST use Outlook 2013. Outlook versions 2016/2019/365 
will not work properly.
Install Outlook 2013 SP1 and then install all recent Windows Update fixes.

Grant the Epicenter mailbox Full Access to other mailboxes

Configure the Full Access privilege on Microsoft 365 using PowerShell. Do not use the Exchange Admin Console (EAC) because you can't 
configure AutoMap. PowerShell is also easier for production deployment because you can allow access to all mailboxes with a single command.

All changes are made from the PowerShell command line. Here are instructions specific to Microsoft 365:

http://emtunc.org/blog/08/2011/grant-and-revoke-access-to-mailboxes-office-365/

IMPORTANT: Notice halfway down the page, under Update, where it says to add  to your command line. This is -AutoMapping $false
required, otherwise Outlook will attempt to open every mailbox that you've set for Full Access, which could take a long time.

Hosted Exchange (not Microsoft 365)

If you are using a Hosted Exchange Server, you must:

Ensure that Epicenter Server is able to connect to the Exchange mailbox without having to enter a username and password. See Outlook 
 for more information.Passwords

In Epicenter Server, go to the   |   window and select  .Tools Exchange Privileges Epicenter has "Full Access" to recipients' mailboxes
Give the account used by Epicenter Server “Full Access” to each mailbox that Epicenter must update. This means that each mailbox must 
be individually configured by an administrator. The process is dependent on the vendor’s web control panel. Below are instructions for 

Test Your Privileges
Changes to permissions can take effect instantly or can take up to two hours. Make sure you follow the steps in  Test Mailbox Access
under .Configuration (typical)

Fixing "execution of scripts is disabled"
When executing the Powershell commands, If you get an error about, "xxx cannot be loaded because the execution of scripts is 
disabled", then please see this link:

http://www.java-samples.com/showtutorial.php?tutorialid=1558

http://technet.microsoft.com/en-us/library/aa996343.aspx
http://emtunc.org/blog/08/2011/grant-and-revoke-access-to-mailboxes-office-365/
http://www.java-samples.com/showtutorial.php?tutorialid=1558
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3.  

Microsoft 365. As part of this process, you must set AutoMap to $false or Outlook will try to open every mailbox, which can take half an 
hour or more.  If you are not able to disable Automap, you will need to use Outlook 2010 with Epicenter, not Outlook 2013, because 
Outlook 2010 will ignore the Automap request from Exchange.

Technique 3: Folder permissions

Folder Permissions give Epicenter Server access to specific folders. Unlike the other techniques, it is configured by the end users, not be the 
administrator, and so is useful in environments where no administrative access is available for Technique 2 or Technique 3.

This technique is also useful in secure environments where Epicenter needs access to update shared contacts, but all other folders need to be 
hidden.

Each user who is receiving updates from Epicenter Server must set up Folder Permissions within Outlook as follows:

Right-click on the Contacts folder and select , as shown below. Do not use the “Share Contacts” selection – it will Change Sharing Permissions
not do what you need. 

Click the  button on the Permissions tab and add the user who is running Epicenter Server.Add

At this point, you have two choices, depending on security preferences and device requirements.

The simplest solution is to assign “Publishing Editor” permissions. Click the droplist next to Permission Level and choose Publishing Editor, as 
shown below:
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Alternatively, if you are NOT running any Windows Mobile or Android devices, you can set minimal permissions if the user is concerned about 
anyone else viewing their contacts. Check the two boxes shown below, then click OK. You’ll now be able to send updates to this user. With the 
permissions set this way, no one else can view the Contacts in that folder, but Epicenter will be able to manage child folders to hold the shared 
contacts.
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Choose a Machine

Carefully consider where you install Epicenter Server. Installing Epicenter in the right place now will save you headaches later from having to 
move the server.

Epicenter is best installed on a machine or VM that is running all of the time. This isn't a requirement, but Epicenter will miss updates if the host 
computer is shut down at the time of a scheduled update.

The host does not necessarily need to be physically secure. Although Epicenter runs with elevated permissions to access Exchange mailboxes, 
the account can be left logged out and so is not accessible to people who try to use the computer.

Epicenter can be installed on a workstation, a server, or a virtual machine. Exact requirements can be found under  . System Requirements
Epicenter has modest requirements and will run in a 1GB Windows 7 VM.

If you are installing on an existing system or virtual machine, make sure that you are running a 32-bit version of Microsoft Outlook. 64-bit Outlook 
is not supported.

Next: Install Epicenter Server

Test Your Privileges
After changing permissions in Exchange, follow the steps under  to make sure your new permissions have taken Test Mailbox Access
effect. Depending on the size of your Exchange installation, permissions can take effect instantly or can take over an hour.

Do not install Epicenter Server on an Exchange Server . Epicenter's required configuration can conflict with these servers and may 
render them unusable.
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Install Epicenter Server

Install and Run Outlook

Log in to the account you created earlier and perform the following steps:

Install Outlook 32-bit. For information about 64-bit Outlook support, see .Using 64-bit Outlook
Install the latest Outlook service pack.
Create a profile for the Exchange mailbox.
Open Outlook to finish configuring the profile and the mailbox.

Install Epicenter Server

Epicenter Server must be installed in the account where you plan to run it.

Install Epicenter Server by running . If you need to download it and you are a registered customer, please go to EpicenterServerSetup.exe ht
.tp://www.connectedsw.com/UpgradeRequest.php

The installer places a shortcut to Epicenter Server on your desktop that matches the icon at the top of this page.

The installer will start Epicenter Server automatically. If you have received your license code, open the Help menu and select Enter License.

You have now completed the installation.

 

Next: Configuration (Typical)

Outlook Passwords

Microsoft Outlook must be configured to access Microsoft Exchange without typing in your username and password. The reason this matters is 
that Epicenter Server runs unattended under Task Scheduler, so it must be able to start Outlook without prompting for a password. Note that 
leaving Outlook open will work for Send Now, but won't work when Epicenter Server runs a scheduled task.

This is generally not a problem if you are on a domain with a dedicated Exchange Server because everything "just works." However, problems 
can arise when you use Hosted Exchange Server because Exchange requires a username/password that's separate from your workstation login. 
Passwords are automatically saved by Outlook 2013/2016/2019/365, but you must make sure you check the box for "Save Password".

Modern Authentication in Microsoft 365 adds complexity. In this case, you must use Outlook 2013 to force a fallback to Basic Authentication 
because Modern Authentication does not work with Epicenter Server.

Using 64-bit Outlook

 

Epicenter Server provides support for 64-bit Outlook as of Build 424. You can ask Technical Support for the download link.

However, there are good reasons not to run it.

The most commonly cited reasons for running Outlook 64-bit are speed and compatibility. However, the 64-bit version of Outlook is larger and 
marginally slower than the 32-bit version. Because of this, even Microsoft  running the 64-bit version. As for compatibility, recommends against
the 32-bit version of Outlook runs quite well on any 64-bit version of Windows, such as Windows 7 64-bit of Windows Server 2008. There is no 
need to run the 64-bit version of Outlook on a 64-bit version of Windows.

Another common reason is because the 64-bit version of Outlook was already installed. This often happens when administrators test the software 
on their own computer. However, Epicenter should be run in a  to prevent the possibility of compromised mailboxes. This secure environment
means a dedicated computer or a dedicated virtual machine. Since an Outlook license allows you to run either the 32-bit or the 64-bit version of 
Outlook, there's no good reason to run the 64-bit version in the dedicated environment.

Exceptions to the above recommendations certainly exist, and for those customers we've created a 64-bit version of Epicenter. But customers 
should prefer the 32-bit version of Outlook whenever possible.

Note: Epicenter Server has supported 64-bit Windows since 2005.

 

http://www.connectedsw.com/UpgradeRequest.php
http://www.connectedsw.com/UpgradeRequest.php
http://thingsthatshouldbeeasy.blogspot.com/2010/06/microsoft-warns-dont-use-64-bit-office.html
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Configuration (Typical)

Exchange Mailbox Updates 

The standard configuration for Epicenter Server is to use "Mailbox" updates, 
where the source address list is copied to a contacts folder in each user’s 
Exchange mailbox. This update method will work with any smartphone that 
supports ActiveSync or the BlackBerry Enterprise Server (BES). This is the 
best method if your smartphone users update wirelessly with Exchange. For 
information on other updates methods, see .Configuration (Alternate)

The initial update can be relatively slow depending on the size of the address 
book, the the number of  users, and whether you are using Hosted Exchange. 
Subsequent updates will be fast because only changes are written.

To the right is a visualization of how Epicenter updates BlackBerry devices. 
This shows an organization with Microsoft Exchange and BlackBerry 
Enterprise Server (BES).

The explanation is as follows:

Epicenter Server reads the contacts from the address book of your 
choice, such as the Exchange Global Address List (GAL) or an Outlook 
contacts folder.
Epicenter incrementally synchronizes the source address book with a 
contacts folder in each mailbox that you specify as a Recipient in the 
task configuration. The new contacts folder is usually created 
underneath the default Contacts folder so that the BlackBerry Enterprise 
Server (BES) will find it.
Changes are sent wirelessly to each user’s phone via Microsoft 
Exchange+ActiveSync and/or BES.

ActiveSync devices such as iPhone and Android follow a similar process, 
except that the BlackBerry Enterprise Server is not needed.

Configuration Roadmap
 

Test Mailbox Access

Create a Task

Send the Update

Customize

 

 

 

Test Mailbox Access

To determine whether the user in the current Outlook profile has sufficient permissions to update a particular user’s contacts, you must be able to 
view the other user’s Contacts folder in Outlook on the computer running Epicenter Server.

Test with Receive-As or Full Access

Most administrators will use this test, which is for (Receive-As) or  (Full Access).Technique 1 Technique 2

Open Outlook on the computer running Epicenter Server.

The steps below MUST work properly before Epicenter Server will be able to send updates using the Mailbox method.
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For Outlook 2013/2016, select   |   |  | File Info Account Settings Account Settings... 
Select your Exchange account
Click Change…
Click More Settings
Go to the  tabAdvanced
Click the  button in the Mailboxes area.Add
Add the target mailbox.
Click .Apply
Open Outlook and click the + next to the other user’s mailbox at the bottom of the folder list.
You should be able to see at least the Inbox and Contacts folders.
Click on the default  folder and ensure that you can view the contents.Contacts
IMPORTANT: Go back to the Microsoft Exchange window and remove all additional mailboxes that you've added.

Test with Folder Permissions

Few administrators will use this test, which is for . These instructions are for Outlook 2010/2013.Technique 3

Open Outlook on the computer running Epicenter Server.
Select the  tab.File
Click , on the left.Open & Export
Click .Other User's Folder
Enter the name of the user that Epicenter is trying to update.
Next to , select "Contacts".Folder type
Click OK.
In the Outlook folder tree on the left, you should see a new section labeled "Shared Contacts". Under that, you should see the name of the 
user whose contacts are shared. The folder will not be named Contacts.
You should now see the contacts in that user's Contacts folder.
You can remove the folder from the list by selecting it and deleting it.

Next: Create a Task

Create a Task

 

Tasks in Epicenter define "who, what, where and when" for the contacts distributed to end-users. Tasks run under Windows Task Scheduler 
unless you disable automated updates.

From the main window in Epicenter Server you can create tasks, rename tasks, delete tasks, and start tasks. You can define  and multiple tasks
you can see the result of scheduled tasks by .viewing the history

 

 After installation, the New Task wizard will be shown automatically. Follow the steps below to create a task.

1. Start the New Task wizard

The New Task wizard is shown automatically when Epicenter Server starts after installation. If the wizard is not displayed, click  on the New
toolbar.

Click  to skip past the welcome page.Next

2. Address Book page

Select the folder containing the contacts that will be distributed to end-users. The most common choices are  or Global Address List Public Folders
. ( )tell me more

Remember that all of these contacts will appear on end-users phones. Consider carefully how much of the GAL you want to distribute if your GAL 
is large. For information on distributing just part of the GAL, see .Send a subset of the GAL

3. Schedule page

Select how often to distribute updates ( .) For testing purposes, you may want to choose .tell me more Only when Send Now is clicked

The default is to run once a day early in the morning. If you use Hosted Exchange you may need to increase this to every 8 hours if you 
encounter network errors. Updates are incremental, so Epicenter puts a very minimal load on the Exchange Server.

Important
Before starting, have you looked at  and followed the instructions under and ?Quick Start Configure Exchange Install Software



18

4. Update Method page

Select how to distribute updates ( .)tell me more

Most customers will use the default, which is  ( .) Update Exchange mailboxes automatically tell me more Send updates by email using 
 is appropriate for POP3 users and  can be used by organizations running BES attachments Update an Exchange Public Folder automatically

5 ( .)tell me more

5. Recipients page

Select who will receive updates ( .) Each mailbox that receives updates will automatically be assigned a license.tell me more

There is no relationship between the contacts folder selected on the Address Book page and the mailboxes on the Recipients page. They do not 
have to be the same or subsets of each other.

6. Destination Folder page

Select the name and location of the folders created in end-users' mailboxes ( .) If you have Windows Phone or Android (pre-4.2.2) tell me more
users, you must choose . Epicenter overwrites existing matching contacts. See  to The default Outlook contacts folder Reserve User Properties
adjust this behavior.

7. Close the wizard

Click the  button to complete the wizard and create the task. The new task will appear in the list of tasks and will be selected.Finish

 

Next: Send the Update

 

 

Send the Update

You are now ready to send the update. Although the default schedule is early each morning, you can send the update immediately be clicking the 
 button on the toolbar.Send Now

Depending on the number of recipients and the number of contacts being distributed, this can take minutes to hours. A status window will give 
you an estimated completion time. Subsequent updates will be incremental and will be much faster.

Once the update is finished, you can review the result by clicking on the History button on the left.

The new contacts can take up to an hour to wirelessly synchronize before they appear on your smartphone. Subsequent updates will be much 
faster.

Troubleshooting

Contacts won't synchronize
Android issues
Outlook issues
Windows Task Scheduler issues
Hosted Exchange

Next: Customize

Customize

 

Epicenter Server can be customized to meet end-user needs and to simplify administration.
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Customization Tasks

Change sort order on phones
Reserve User Properties
Send to Exchange distribution list
Send a subset of the GAL
Send distribution lists
Send a SharePoint list
Create multiple tasks
Scripting

 

 



20

1.  

2.  
3.  
4.  
5.  
6.  
7.  
8.  
9.  

10.  

11.  
12.  
13.  
14.  
15.  
16.  
17.  

1.  
2.  
3.  
4.  
5.  
6.  
7.  
8.  

1.  

Configuration (Alternate)

Public Folder updates

Epicenter Server supports sending updates to an Exchange Public Folder, which BES 5 is able to distribute to all BlackBerry users.

This strategy has two advantages:

Epicenter Server requires no special permissions to access users’ mailboxes.
Epicenter Server only has to update a single folder instead of updating a folder per mailbox, so update times are dramatically reduced.

A diagram of this update strategy is shown to the right. TODO

Configuration

This section describes how to configure Epicenter Server to send updates to a Public Folder. This procedure only works with BlackBerry 
Enterprise Server version 5. Distributing Public Folders is not supported for ActiveSync devices such as the iPhone. For detailed information on 
each of these steps, see  on page 41.Task Configuration

Install Epicenter Server by running EpicenterServerSetup.exe. Start Epicenter Server if it’s not already running and follow the steps below. 

In Microsoft Outlook, create a new Public Folder where you want to place the contacts. Make sure you create a Contacts folder and not a 
Mail folder.
Set the BlackBerry Enterprise Server (BES) to distribute the new folder using the instructions in the next section.
In Epicenter Server, click the New button on the toolbar to create a new task.
Click Next on the first page of the wizard.
Choose Global Address List (GAL).
If you want a subset of the GAL, click the Folder button to choose an Exchange address list, then click OK.
Click Next.
On the Schedule page, select Every 1,2,3… day(s) and click Next. This will send daily updates at 6am.
On the Update Method page, choose “Update an Exchange Public Folder automatically.” Click Next.
On the Destination Settings page, click the Folder button to choose a Public Folder. If you have many public folders, or if you have a slow 
connection, this can take quite a while to complete.
Select the folder you created in Step #1 and click OK.
Click Finish.
The new task should appear in the list of tasks and should be selected.
Click the Send Now button on the toolbar.
Epicenter Server will create a copy of the Step 5 address book in the folder you specified in Step 11.
Review the result by clicking on the History button on the left.
The new contacts can take up to an hour to wirelessly synchronize before they appear on your BlackBerry device. Subsequent updates 
will be much faster.

If you run into any difficulties, please send email to  or visit our knowledgebase at support@connectedsw.com http://www.connectedsw.com
. /support

Enable BES 5 Public Folder Synchronization

BES 5 is able to synchronize selected Public Folders to all devices, but the functionality must be enabled in the admin console. This procedure to 
enable a folder to synchronize is taken from KB19111 on www.blackberry.com.

Overview

Public folder synchronization can be enabled in the BlackBerry Administration Service using the following steps:

Open the BlackBerry Administration Service.
In the  menu, expand .Servers and      Components BlackBerry Solution Topology
Expand .BlackBerry Domain
Expand .Component View
Select  .Email
Click .Edit Component
In the  section, select the public contact folders to synchronize to the BlackBerry smartphone.Published public contact folders
Click .Save All

To assign the public folder to a user:

This update method is only useful for BlackBerry devices connected to BES 5.

mailto:support@connectedsw.com
http://www.connectedsw.com/support
http://www.connectedsw.com/support
http://www.blackberry.com.
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Click  .Manage users
Select the user from the list.
Click .Default Configuration
Select .E-mail
Click .Edit user
In , select the public folder to be assigned to the user.Published public contact folders  
Click  .Continue to user information edit
Click .     Save all

Additional Information

The BlackBerry service account requires  permission for any public contact folder configured for wireless synchronization in the BlackBerry Owner
Administration Service. If the folder exists within another folder, the BlackBerry service account requires permissions for the entire Owner 
directory structure. 

Note: To reduce the permissions required for the BlackBerry service account, the published contact public folders could be placed as a top-level 
folder.

BlackBerry smartphone users require  and  permissions for any public contact folder to be enabled for synchronization with their Read Visible
accounts. Alternatively, default can be listed as .Reviewer

To verify the permissions for a public folder, complete the following steps:

In Microsoft Outlook, locate the public contact folder to be configured for synchronization.
Right-click the folder and select Properties.
Click the Permissions tab.

 

 

Attachment Updates for POP3/IMAP Users

Sometimes you need to send address books to users who aren’t on an Exchange Server. These users may not be using a smartphone or they 
may be synchronizing their smartphone with a USB cable. Epicenter supports these users by emailing them an attachment that is loaded into 
Outlook with the Epicenter Client.

This chapter describes how to configure Epicenter Server to send email containing an attached address book update to a list of recipients. This 
configuration can be used to update the address book of POP3 and IMAP users who cannot synchronize with Microsoft Exchange.

Quick Start – Send to Yourself

If you are in a hurry to see Epicenter work, this section provides a short summary of how to send an address book to yourself so you can see 
Epicenter Server and the Epicenter client working together. For detailed information on each of these steps, see .Task Settings

Install Epicenter Server by running EpicenterServerSetup.exe. Start Epicenter Server, then click the New button on the toolbar to create a new 
task. Follow these steps to create a minimal configuration:

Click Next on the first page of the wizard.
Set the Source Address Book to your usual email client.
If the address book to be distributed is not the default address book, click the Folder button and choose the appropriate folder.
Click Next.
Set the Schedule as Weekly and click Next.
On the Update Method page, choose “Send updates by email using attachments.” Click Next.
Under Recipients, enter your email address and click Next.
Under Destination Folder, select “The folder name below”, then type the name of the folder that should be created when people receive 
this address book and click Next. : Use a folder name or address book name that is different from any of your existing foldersIMPORTANT
/address books.
Click Finish.
Click Send Now on the toolbar.
Epicenter Server should now send you your own address book. After Epicenter indicates that the email has been sent, you may need to 
go to your email program to tell it to actually send the email.
Since you are sending to yourself, check your email a few times until the address book arrives. Open the email when you receive it.
Click on the link to the Epicenter client to download it.
Finally, in the email message, double click the attachment Master.AMZ to update your address book.

If everything worked properly, the next section describes how to configure Epicenter Server for production use.

Going Live

Once you have tried Epicenter Server and understand how it works, you will want to update your configuration to send email to your users. This 
is an easy change and will only take a minute.
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Open the Epicenter Server configuration window by selecting the task you created earlier and clicking Edit on the toolbar. You will see the same 
pages you configured in the Quick Start. Make the following changes:

On the Address Book tab, make sure that you have selected the folder you want your users to receive.
On the Schedule tab, set the schedule as desired ( .)tell me more
On the Recipients tab, enter all of the users who should receive the distribution. If you are using Microsoft Exchange, you may want to 
manage the distribution list in Exchange and just enter the name of the distribution list in this window.
On the Email Message tab, the default message works for most situations. If you customize it, there are some limitations. See Email 

 for more information.Customization
For information on how to set the Destination Folder page, please see  . The name of the Destination Folder can Destination Folder page
be different from the name of the folder you chose on the Address Book tab.
The Mirror Folder page is not used when distributing attachments.
When you click OK, you’ll be offered the opportunity to send an update. Choose All Recipients.

If you run into any difficulties, please submit a trouble ticket to our support site at .http://www.connectedsw.com/support

 

Email Customization

Creating the Email Messages

End-users receive an email notification when they receive an address book update. The email provides instructions on how to download the 
Epicenter client so that they can use the update. The default message points to Connected Software’s web server.

Connected Software does not require you or your users to enter any identifying information to download the Epicenter client. Connected Software 
will not receive a copy of your address book update.

The default message will work well for most users, but you can customize it with instructions specific to your environment.

Important
All URLs that point to Connected Software are case-sensitive. In other words, linking to  will http://www.connectedsw.com/cgi-bin/GetEpicenter
work, but linking to  will .http://www.connectedsw.com/cgi-bin/getepicenter not

Sample email for Attachment Recipients

By default, all of your recipients receive an attachment with the email that contains Master.AMZ. This file can only be read by the Epicenter client, 
so it is important that the email tell your users where to get the Epicenter client.

If you change the email, you should make sure you tell the users what they are getting, where to get the client, and how to open the attachment. 
For example:

This email contains an update to your address book. New users should
go to  and follow thehttp://www.connectedsw.com/cgi-bin/GetEpicenter
prompts to download the right software.

Double click the attachment to update your address book.

 

You may also wish to include additional information for specific email clients. For example, when the preview pane is enabled in Microsoft 
Outlook, the attachment doesn’t appear. Users must open the message to see the attachment. For Outlook Express users, the attachment does 
appear, but it’s in a drop list in the top right of the preview pane.

 

Important
Before Epicenter sends this email, additional information is added after the text “GetEpicenter” (without the quotes.)  This information 
contains the version of Epicenter that users should download and typically looks something like “?VER=420”. This is how Epicenter 
ensures that new users receive the proper version of the Epicenter client.

http://www.connectedsw.com/support
http://www.connectedsw.com/GetEpicenter
http://www.connectedsw.com/cgi-bin/getepicenter
http://www.connectedsw.com/cgi-bin/GetEpicenter
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Task Settings

This section provides detailed descriptions of each of the property pages in the 
Task Settings.

 

Task Settings Pages
 

Address Book page
Schedule page
Update Method page
Recipients page
Destination Folder page
Email page
Mirror Folder page

   

Address Book page

The Address Book tab determines which address book folder is distributed by Epicenter Server. For most formats, the default folder for that 
address book will automatically be selected if you do not click File or Folder.

Other notes about the Address tab:

To select a particular address list in the GAL, choose  and click the  button. Also see the section Global Address List (GAL) Folder Send a 
.subset of the GAL

Sending multiple folders is not supported. Create multiple tasks instead.
The address book you choose on this page does not have to include the email addresses you specify on the Recipients page.

Schedule page

The Schedule tab determines how often Epicenter Server processes updates. For Mailbox and Public Folders updates, each time an update is 
run, all destination folders are individually synchronized.
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Attachment updates: an update email is only sent if the address book has changed. Therefore, for attachment updates, you should set the 
schedule based on how rapidly users need to receive changes, not how often you change the server.

Mailbox updates: Hosted Exchange sites may experience network errors, especially when there are hundreds of mailboxes to update. In this 
case, the solution is to increase the frequency of updates, such as every 4 to 6 hours. Since updates are incremental, there is minimal penalty for 
unnecessary updates.

Update Method page

The Update Method page to determine the type of a task. This page only appears when you are creating a task. Once you click Finish in the task 
creation wizard, the update method cannot be changed. Most sites will use  as described in Update Exchange mailboxes automatically Configurati

. Attachment updates and Exchange Public Folder updates are described in .on (Typical) Configuration (Alternate)
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Recipients page

The Recipients page selects who should receive updates from Epicenter Server based on the schedule you chose in the Schedule tab. You will 
not see this tab if you selected "Update an Exchange Public Folder automatically" for the update method.

You can edit the list of names by typing email addresses into the window, one per line, just as if you were using Windows Notepad. In addition, 
you can add to the list by from your address book clicking the Add button, which will give you a selection list similar to the following:

Instead of entering individual email addresses, you can instead enter an Exchange distribution list. This has the added advantage that 
mailboxes will automatically be removed from the recipient list when their mailbox is deleted. See .Send to Exchange distribution list



26

Destination Folder page

The Destination Folder page selects where Epicenter Server creates contacts in the recipient's mailbox.

Exchange Mailbox Updates

If you are distributing updates via Exchange Mailboxes, the Destination Folder window looks like this:

Android (pre-4.2.2) and Windows Mobile devices will only synchronize with the default Outlook Contacts folder.
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There are some critical differences between the two choices for where Epicenter places its contacts. The first choice, , gives This Outlook folder
a much better end user experience because the end-user's personal contacts do not get mixed with the contacts distributed by Epicenter. It can 
be frustrating for end-users to suddenly have their personal contacts intermingled with hundreds of corporate contacts. Syncing with subfolders is 
only supported on the iPhone and Android devices 4.2.2 or later.

If you have have to support Android (pre-4.2.2) or Windows Phone devices, then  is your only choice The default Outlook contacts folder
because those phones can't sync with subfolders. One feature of this choice is that Epicenter will "take over" any of the user's contacts that also 
exist in the user's Contacts folder. This means that the contact will be completely overwritten by Epicenter. If you want to allow user's to control 
certain fields, then use Tools |  .Reserve User Properties

Organizations that must support arbitrary devices will usually need to use  folder, which is supported by all phone The default Outlook contacts
types. However, larger organizations with a dedicated Exchange Server can mix the two choices by creating two tasks based on two different 
Address Lists, one for iPhone/newer Android users and one for other smartphone users.

Note that, if you change the folder type or you change the folder name after you've already sent updates, you will create two separate folders in 
user's mailbox that each has a copy of the contacts. You can use Tools | Cleanup Mailboxes to remove the old folder.

Setting the  is important. If you don't set the Category, then users will not be able to filter the shared contacts.Category

The checkbox to  is particularly useful when distributing the GAL if your users are used to the list being Preserve the original display name
sorted by first name. Otherwise, contacts will be sorted based on Outlook's default behavior on the computer where Epicenter Server is running.

Public Folder Updates

If you are distributing updates via a Public Folder, the Destination Folder window looks like this:
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POP3 Attachment Updates

If you are distributing updates via an email attachment, the Destination Folder window looks like this:

In most organizations, administrators will want to ensure a consistent experience and so should select either "The folder name below" or "The 
folder and email application below", depending on whether users all use the same email client.

An advantage to choosing "The folder and email application below" is that users will have a simplified experience with the Epicenter client, will be 
placed into a "non-interactive" mode where no configuration wizard will be shown. Note that users will not be able to override the administrative 
settings if the chosen email application does not exist

The final choice, "A folder chosen by each user," works well for users who want maximum control, but it can make troubleshooting clients a little 
more difficult if everyone does things differently.
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With the exception of ActiveSync users, the folder where Epicenter keeps its contacts should be separate from the user's normal contacts 
folder. There are two reasons for this. First, if you need to remove the Epicenter contacts from a user's computer, it is very difficult if they are 
mixed with other contacts. Second, any changes made by users to Epicenter contacts may be lost during the next update, so separating the 
Epicenter contacts into their own folder helps users understand the distinction.
If you choose the name of a folder that already exists on the client (such as "Contacts" for Microsoft Outlook), contacts from Epicenter will be 
mixed in with that folder. It's best to choose a folder name that is likely to be unique.

Important When the Epicenter client creates a folder in Microsoft Outlook, the folder will always be created underneath the default Contacts 
folder. This ensures that smartphones syncing via USB will be able to sync with the folder. Users can move the folder to elsewhere in the folder 
tree, but this may break phone synchronization.

One point to be aware of is that some users are not familiar with their email client's ability to maintain multiple address books or multiple contacts 
folders, especially with Outlook 2002. These users may be confused may require training in how to open use the multiple folders.

Email page

Use the  page to change the message your users receive in their email. Epicenter Server includes a default message that is appropriate for Email
most situations. You can click Restore Defaults to go back to the default message, which includes the URL to download the Epicenter client as 
shown below.

The instructions in the email are very important to ensure that users successfully load address books they receive. See   for Email Customization
more information on writing these emails, particularly how to specify links to the client download server.

Mirror Folder page

The Mirror Folder is where Epicenter Server writes a copy of the address book. This is for unusual situations where you need to create the 
distribution file without actually sending any updates. A mirror file will be in .amz format, which can be loaded with the Epicenter Client.

The Recipients page is usually left blank when you use a Mirror Folder and the update is distributed with a third party product.

You will only see the  property page if this is an Attachment update task. This property page does not appear in the wizard when Email
you initially configure the task.

You will only see the Mirror Folder page if this is an Attachment update task. This property page does not appear in the wizard when you 
initially configure the task.
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Customization

This section describes various customization tasks that make Epicenter Server 
easier to use and administer.

 

Customization Tasks
 

Change sort order on phones

Reserve User Properties

Send to Exchange distribution list

Send a subset of the GAL

Send distribution lists

Send a SharePoint list

Create multiple tasks

Scripting

   

 

 

Change sort order on phones

 

If contacts aren’t sorted the way users are used to seeing them, you can change the way Epicenter Server writes the display name This won't 
affect the sort order in Outlook, but it will affect the sort order on most phones.

Select the task in Epicenter and click Settings on the task bar.
Go to the Destination Folder page.
Check the box labeled “Preserve the original display name.”
Click OK.
Click Send Now.

Note that this will cause a full rewrite of all contacts in all mailboxes and so may take a substantial amount of time in large organizations.

 

Reserve User Properties

Reserved Properties allow you to designate fields that Epicenter Server will never overwrite. Users can safely put information into these fields 
and that information will not be changed or deleted by Epicenter Server. For example, you could designate Home Phone and Home Address to 
be reserved. End users would then be able to add this information to contacts created by Epicenter and Epicenter would not overwrite it.

This feature is particularly useful when you are distributing updates to the default Contacts folder in Outlook. By default, Epicenter Server will 
overwrite existing contacts that match. You can use Reserve User Properties to ensure that user data in fields like Notes or Home Phone won't 
be overwritten.

This section only applies to  or  updates and is ignored for  updates.Mailbox Public Folder Attachment
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Hint: you should select  to reserve the Notes field in Outlook.Comment

Prevent Overwrites of Existing Contacts

This feature is particularly useful with Android and Windows Phone devices to prevent users from losing data in the initial sync.

The problem happens when:

End users have coworkers in their default Contacts folders in Outlook.
Epicenter is required to write contacts to this folder because Android (pre-4.2.2) and Windows Phone devices don't support syncing 
subfolders with contacts.
Epicenter will "take over" and overwrite any contacts that match a contact being distributed.

Using Reserved Properties allows you to define fields that aren't present in the GAL and so make sense for a user to manage themselves.

Note that a field is either completely reserved or completely not reserved. There's no intermediate setting for something like "write the field if the 
user doesn't have anything there." Such a setting would "sometimes" work, and whether it works or not depends on what Epicenter found when it 
first wrote the contacts sometime in the distant past. This is not a manageable scenario.

Setting Reserved Properties

The Reserve User Properties command is found under the Tools menu. It opens this window:

This command allows you to choose fields in Outlook that will be reserved for each end-user when Epicenter updates contacts. End users can 
put data into these fields from Outlook, OWA or their phones and Epicenter will not overwrite or delete that data.

Selected fields are reserved. Unselected fields (as shown in the picture above) are not reserved. Reserving a field is an all-or-nothing choice. If a 
field is reserved, then Epicenter will never overwrite it, even if the field in the end-user's mailbox is empty.

Using "Never delete contacts"

Do not use "Never delete contacts" if you have Outlook 2010 clients running the Outlook Social Connector (OSC), which is the default in 
Outlook 2010. You will end up with many duplicates if you use this combination. Related symptoms of this problem can be seen in http://w

.ww.connectedsw.com/faq.php?faq=190

http://www.connectedsw.com/faq.php?faq=190
http://www.connectedsw.com/faq.php?faq=190
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The “Never delete” checkbox at the bottom of this dialog allows you to decide what happens when Epicenter needs to delete a contact that 
contains data entered by the end-user in any of the Reserved Properties fields. If you check this box, then Epicenter does the following instead of 
deleting a contact that contains user data:

Removes internal markers on the contact indicating that it’s being controlled by Epicenter.
Removes data from all fields controlled by Epicenter, except for the display name.
Retains data entered by the user.
Moves the contact to the default Contacts folder, if necessary.

Send to Exchange distribution list

The recommended configuration for Epicenter Server to manage recipients is to create a static Distribution List in Exchange that defines who 
receives updates from Epicenter Server. To tell Epicenter to use that distribution list, open the Settings for a task, go to the Recipients tab, and 
enter the email address of the group (such as: group@mycompany.com)  Epicenter reads the recipients from this distribution list before each 
update, so changes to the distribution list will be picked up automatically. Epicenter does not use Outlook's Offline Address Book (OAB) to 
expand the distribution list, so you do not need to update the OAB to get Outlook to recognize the changes.

Epicenter does not support sending to hidden distribution lists.

You must use a static distribution list. Dynamic distribution lists are not supported. One workaround is to run a nightly PowerShell task that 
creates a static distribution list based on some criteria. Connected Software does not offer support on how to do this, but there are several 
examples on the web, such as this one:

http://serverfault.com/questions/488365/creating-a-dynamic-group-in-active-directory-with-users-from-a-ou

Send a subset of the GAL

You can distribute the contacts from any Address List, not just the Global Address List. For example, many Exchange Server accounts have a 
default Address List named "All Users", which does not include contacts, distribution lists or resources. You can select it as follows:

Open Epicenter Server.
Edit the  for your task.Settings
Go to the  page.Address Book
Click the  button.Folder
Select the desired address list.

You can create a custom Address List if you wish to use a specific query, such as both Users and Contacts. Details are below.

Dedicated Exchange Servers

Customers with a dedicated Exchange Server can create a new static or dynamic address list from the Exchange Console, which will allow you to 
exactly the define the subset of the GAL to be sent by a task:

The information below is provided as a service to our customers. Connected Software does not provide technical support on creating address 
lists in Exchange.

Exchange 2010: http://technet.microsoft.com/en-us/library/bb125036(v=exchg.141).aspx
Exchange 2013: http://technet.microsoft.com/en-us/library/bb125036(v=exchg.150).aspx
Exchange 2016/2019: https://docs.microsoft.com/en-us/Exchange/email-addresses-and-address-books/address-lists/address-list-procedures?
view=exchserver-2019#create-address-lists

 Office 365

It's also possible for Office 365 environments to create Address Lists.  You must be on the Enterprise (‘E’ plans) or Education (‘A’ plans.) Here 
are some links describing how:

https://docs.microsoft.com/en-us/exchange/address-books/address-lists/manage-address-lists

http://www.flexecom.com/gal-segmentation-in-office-365/.

This section is about how to select who receives updates from Epicenter using a distribution list. If you want to send distribution lists so 
that the distribution lists appear on the smartphone, please see .Send distribution lists

Distribution Lists in Exchange/Active Directory are different from Address Lists. A Distribution List defines who receives updates from 
Epicenter Server and is used on the Recipients page. An Address List defines which contacts are distributed when the Address List is 
selected on the Address Book page.

http://serverfault.com/questions/488365/creating-a-dynamic-group-in-active-directory-with-users-from-a-ou
http://technet.microsoft.com/en-us/library/bb125036(v=exchg.141).aspx
http://technet.microsoft.com/en-us/library/bb125036(v=exchg.150).aspx
https://docs.microsoft.com/en-us/Exchange/email-addresses-and-address-books/address-lists/address-list-procedures?view=exchserver-2019#create-address-lists
https://docs.microsoft.com/en-us/Exchange/email-addresses-and-address-books/address-lists/address-list-procedures?view=exchserver-2019#create-address-lists
https://docs.microsoft.com/en-us/exchange/address-books/address-lists/manage-address-lists
http://www.flexecom.com/gal-segmentation-in-office-365/
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http://blog.westmonroepartners.com/how-to-create-and-configure-address-lists-in-an-office-365-hybrid-environment/

http://blogs.technet.com/b/exchange/archive/2013/02/14/address-book-policies-jamba-jokes-and-secret-agents.aspx

http://technet.microsoft.com/en-us/library/jj891096(v=exchg.150).aspx
 

Other Hosted Exchange Environments

Other than Office 365, most Hosted Exchange environments do not support creating dynamic address lists. One workaround is to use   in scripting
Epicenter to filter which contacts are distributed.

Related Keywords: part of the gal, exclusion list, excluding contacts, address list, dynamic address list.

Send distribution lists

Most smartphones do not support having distribution lists in the address book. Therefore, distribution lists in an Outlook contacts folder are not 
synchronized with phones.

To work around this problem, Epicenter Server handles Exchange distribution lists by creating a contact with the name as the distribution list and 
the email address of the Exchange distribution list. (By default, distribution lists in Exchange have their own email address.) This has the 
additional benefit that Exchange takes care of expanding the distribution lists, so even new users on a mailing list will receive emails on the list, 
even if Epicenter has not yet sent an update.

If you aren't using Exchange, or you are distributing an Outlook contacts folder instead of the GAL, then you will need to have your email server 
receive on a single email address and resend to list members. Create a distribution list on your mail server, then create a contact in your address 
book that represents that distribution list.

It is not possible to have Epicenter send the actual distribution lists that include the members.

 

Send a SharePoint list

 

Epicenter Server can distribute a Sharepoint contact list by syncing Outlook to the SharePoint contacts list and then selecting that folder in 
Outlook as the source address book. Outlook must be left open for this to work.

For information on configuring Outlook to sync with SharePoint, see the following articles: (these articles are hosted by other organizations and 
Connected Software is not responsible for their content.)

http://www.exchangedefender.com/help/2011/08/09/can-i-synchronize-items-from-sharepoint-into-outlook/

http://hosting.intermedia.net/support/kb/default.asp?id=1130

http://arrow-tips.com/archives/854

  

Connected Software recommends that you NOT use Outlook 2007, which appears to have problems syncing to Sharepoint on a schedule. See 
this article for more information:

http://www.windowsitpro.com/article/outlook-2007/outlook-2007-and-sharepoint-synchronization-how-it-really-works-98119

  

The information above is provided as a service to our customers. Connected Software does not provide free technical support for configuring 
Outlook or Sharepoint.

 

Create multiple tasks

You can create multiple tasks that run at different times, distribute to different recepients, and/or distribute different contacts.

This section is about how to send distribution lists so that the distribution lists appear on the smartphone. If you want to send your 
updates a distribution list, please see .to Send to Exchange distribution list

http://blog.westmonroepartners.com/how-to-create-and-configure-address-lists-in-an-office-365-hybrid-environment/
http://blogs.technet.com/b/exchange/archive/2013/02/14/address-book-policies-jamba-jokes-and-secret-agents.aspx
http://technet.microsoft.com/en-us/library/jj891096(v=exchg.150).aspx
http://technet.microsoft.com/en-us/library/jj891096(v=exchg.150).aspx
http://www.exchangedefender.com/help/2011/08/09/can-i-synchronize-items-from-sharepoint-into-outlook/
http://hosting.intermedia.net/support/kb/default.asp?id=1130
http://arrow-tips.com/archives/854
http://www.windowsitpro.com/article/outlook-2007/outlook-2007-and-sharepoint-synchronization-how-it-really-works-98119
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There are several good reasons to do this:

Device segmentation: Android prior to 4.2.2 and Windows Mobile do not support subfolders under contacts, but iOS and newer 
Android devices do support subfolders. You can create one task that distributes to a subfolder for iOS users and a second task that distributes 
to the default contacts folder for Android and Windows Mobile users. See  for more information.Destination Folder
Address list segmentation: You could create one task for each department in the company. Each task would distribute only to recipients in 
that department and only contacts particular to that department would be distributed.
Information filtering: You could create one task for executives that distributed contacts with home addresses and phone numbers and a 
second task that distributed contacts to everyone else without this information. This scenario requires that the home addresses and phone 
numbers be .added using scripting

Multiple tasks can safely distribute to the same folder. For example, you could have one task that distributes Address List 1 to Users A, B, and C. 
You could have a second task that distributes Address List 2 to Users C, D and E.

Licenses are based on the total number of mailboxes, regardless of how many tasks those mailboxes appear in. For more information, see Manag
.e user licenses

Scripting

Epicenter Server supports using VBScript to modify the contacts before they are distributed. Common uses for this function include:

Removing properties
Moving properties to a different field
Selecting contacts by content(especially on Hosted Exchange where you can't create address lists.)
Filtering fields (for example, some companies consider the Home Phone to be confidential.)
Removing pictures

Here's an example script to remove all contacts that have no company name.  This script must be named Fixup.vbs and should be placed in the 
same directory as Epicenter Server.exe. (Normally C:\Program Files (x86)\Connected Software\Epicenter Server)

Option Explicit

Dim c

Dim name

 

for each c in Contacts 

  name = c.GetProperty(amCOMPANY_NAME)

  if name = "" then c.Remove

Next

You can find a second sample script at this link. It will remove all contacts not in a category. This particular script is useful when your source 
address book is an Outlook contacts folder. (The GAL does not support categories.)
http://www.connectedsw.com/faq.php?faq=158

For more complex needs, please  for more information. There may be a customization charge, depending on your contact technical support
requirements.

The list of supported fields is as follows. (Some of them are for future expansion only and aren't actually supported by any email client, such as 
amGOVERNMENT_ID_NUMBER) Note that the quotes should be included for any fields that show quotes below. Several of these fields are not 
supported in the GAL, such as the Home Address fields.

amDISPLAY_NAME
amADDRTYPE
amEMAIL_ADDRESS
amCOMMENT
amCALLBACK_TELEPHONE_NUMBER
amGENERATION
amGIVEN_NAME
amGOVERNMENT_ID_NUMBER
amBUSINESS_TELEPHONE_NUMBER
amHOME_TELEPHONE_NUMBER
amINITIALS
amKEYWORD
amLANGUAGE
amLOCATION
amSURNAME
amPOSTAL_ADDRESS

http://www.connectedsw.com/faq.php?faq=158
http://www.connectedsw.com/support/index.php?/Tickets/Submit/RenderForm/4
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amCOMPANY_NAME
amTITLE
amDEPARTMENT_NAME
amOFFICE_LOCATION
amPRIMARY_TELEPHONE_NUMBER
amBUSINESS2_TELEPHONE_NUMBER
amCELLULAR_TELEPHONE_NUMBER
amRADIO_TELEPHONE_NUMBER
amCAR_TELEPHONE_NUMBER
amOTHER_TELEPHONE_NUMBER
amTRANSMITABLE_DISPLAY_NAME
amPAGER_TELEPHONE_NUMBER
amPRIMARY_FAX_NUMBER
amBUSINESS_FAX_NUMBER
amHOME_FAX_NUMBER
amBUSINESS_ADDRESS_COUNTRY
amBUSINESS_ADDRESS_CITY
amBUSINESS_ADDRESS_STATE_OR_PROVINCE
amBUSINESS_ADDRESS_STREET
amBUSINESS_ADDRESS_POSTAL_CODE
amBUSINESS_ADDRESS_POST_OFFICE_BOX
amTELEX_NUMBER
amISDN_NUMBER
amASSISTANT_TELEPHONE_NUMBER
amHOME2_TELEPHONE_NUMBER
amASSISTANT
amHOBBIES
amMIDDLE_NAME
amDISPLAY_NAME_PREFIX
amPROFESSION
amPREFERRED_BY_NAME
amSPOUSE_NAME
amCOMPUTER_NETWORK_NAME
amCUSTOMER_ID
amTTYTDD_PHONE_NUMBER
amFTP_SITE
amMANAGER_NAME
amNICKNAME
amPERSONAL_HOME_PAGE
amBUSINESS_HOME_PAGE
amCOMPANY_MAIN_PHONE_NUMBER
amCHILDRENS_NAMES
amHOME_ADDRESS_CITY
amHOME_ADDRESS_COUNTRY
amHOME_ADDRESS_POSTAL_CODE
amHOME_ADDRESS_STATE_OR_PROVINCE
amHOME_ADDRESS_STREET
amHOME_ADDRESS_POST_OFFICE_BOX
amOTHER_ADDRESS_CITY
amOTHER_ADDRESS_COUNTRY
amOTHER_ADDRESS_POSTAL_CODE
amOTHER_ADDRESS_STATE_OR_PROVINCE
amOTHER_ADDRESS_STREET
amOTHER_ADDRESS_POST_OFFICE_BOX
amWEDDING_ANNIVERSARY
amBIRTHDAY
amLAST_MODIFICATION_TIME
amMESSAGE_CLASS
amENTRYID
"Mileage"
"BillingInfo"
"FollowUp"
"Categories" (Multivalued string, separated with semicolons)
"Email1Address"
"Email2Address"
"Email3Address"
"Email1Name"
"Email2Name"
"Email3Name"
"FileAs"
"User1"
"User2"
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"User3"
"User4"
"HomeAddress"
"BusinessAddress"
"OtherAddress"
"WebPage"
"Email1AddressType"
"Email2AddressType"
"Email3AddressType"
"NetMeetingServer"
"UniqueNickname"
"OtherWebUrl"
"DefaultMailingAddress" (Integer)
"IPphone"
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Administrative Tasks

This section describes administrative tasks that may be required when using 
Epicenter Server.

 

Administrative Tasks
 

Enter the license code

Run as a Windows Service

View History

Manage recipients using Active Directory

Manage user licenses

Remove Epicenter contacts from mailbox(es)

Handle terminated employees

Force full resync

Client installation

Using the Exchange MAPI Client

Upgrade

Extend Support Subscription

Remove a recipient

Move Epicenter Server to a new computer

   

 

 

Enter the license code

 

After you purchase the software, you will receive your license code by email. You can enter it into Epicenter Software by going to the Help menu 
and selecting Enter License code. Epicenter Server requires an internet connection to contact the Connected Software license manager. Your IP 
address, computer name and account name are logged when the software is activated.

If you purchase more users, you will not receive a new license code. Go to the Help menu in Epicenter and select Sync License. Orders for 
additional licenses may take up to one business day to process, so this may not work immediately after you purchase.

If you , you will not receive a new license code and you will not need to enter anything into Epicenter Server.renew your subscription

 

Run as a Windows Service
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Epicenter runs updates under the Windows Task Scheduler, which is itself a service. Once you’ve defined the update schedule for a task in 
Epicenter, you can safely close Epicenter and log out and updates will still be distributed.

 

View History

 

Epicenter Server keeps a history of all updates that are distributed. To view the history, click the History button on the left-hand size of the 
Epicenter Server window.

The first line shows how many contacts were read from the source address book.

The following lines show the update information for each mailbox. The numbers will only match the first line on the initial update. After that, the 
following lines list the incremental changes. Because updates can be aborted or individual mailboxes can fail due to network issues, it's possible 
to have different update information for different mailboxes.

 

Manage recipients using Active Directory

 

Most organizations running Epicenter Server will want to manage recipients using a Distribution List instead of manually entering recipients into 
the Epicenter Server properties page. With this strategy, Epicenter will automatically pick up new employees without requiring manual 
intervention. For details, see .Send to Exchange distribution list

Epicenter will not automatically delicense mailboxes with this technique. See .Manage user licenses

Manage user licenses

 

Licenses in Epicenter Server are based on the number of mailboxes. A mailbox will only be counted once, even if it appears in multiple tasks. If 
you distribute to an Exchange distribution list, each recipient mailbox will be assigned a separate license.

Licenses will automatically be assigned as long as there are licenses remaining. Therefore there's no need to manually assign user licenses 
when you configure Epicenter Server.

Licenses will continue to be assigned even if you remove a mailbox from tasks because a license can only be deassigned if the mailbox is 
deleted. You can manually disable a license for a mailbox under  | , but you cannot reenable a mailbox once it is Help Manage Licensed Users
disabled. For more information on the Manage Licenses window, see the  page.Help menu

 

Remove Epicenter contacts from mailbox(es)

 

It's often necessary to "clean" a mailbox and remove any contacts and/or folders managed by an Epicenter task. You can do this with the | Tools 
 command. Epicenter keeps a history of each folder in each mailbox that is updated. If you remove recipients from tasks, Cleanup Mailboxes  

rename destination folders, or delete tasks,  you can have orphan contacts left in the users’ mailboxes. This command will remove those contacts.

Mailboxes accessed by this command are not subject to license restrictions.  Therefore, you can clean up mailboxes for users who are no longer 
licensed.

This command will not delete contacts that were not created by Epicenter. Therefore, any contacts created by end-users will not be affected.

This menu option only applies to Mailbox or Public Folder updates. This menu option is ignored for Attachment updates.

The behavior of this command is affected by the  checkbox under .Never Delete Reserve User Properties

To use the command, first look under  AND select the original task name where the contacts were distributed. This list will include Folder Name
tasks, even if they were deleted. To clean all of the listed recipients, just click the  button. To clean just selected mailboxes, select the Clean
desired recipients, then click the  button. You can select more than one recipient by holding Ctrl when you click.Clean

You can also use the Forget button to remove mailboxes that have been deleted or shouldn't be cleaned.

 

Handle terminated employees

Connected Software does not provide free technical support for Exchange administration tasks such as creating and using distribution 
lists in Exchange or Active Directory.
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When employees leave the company, you often don't want them to take a copy of your address book with them. A common question is whether 
Epicenter automatically removes the contacts when their Exchange account is removed. The answer is no, because Epicenter talks to the user’s 
mailbox in Exchange, not to the user’s smartphone. So if a user’s account is terminated, then Epicenter no longer has access to the mailbox and 
isn't able to make any changes.

However, for terminated employees, removing the Epicenter contacts fall under the larger question of how do you remove all company-centric 
Exchange content from the user’s device? Once you do that, the Epicenter contacts will disappear at the same time because the Epicenter 
contacts are part of the user's Exchange Mailbox.

If you want to explicitly remove the Epicenter contacts from a user’s phone while that user's mailbox is still active, you should:

Remove that user from all tasks, either by removing the user from the Epicenter recipients list or removing the user from the Exchange 
distribution list.
Use the Clean Mailboxes command in Epicenter (under the Tools menu), which will remove all Epicenter contacts from the mailbox, which 
will then sync with the smartphone.

Finally, hiding a user from the GAL will not force Epicenter to remove the contacts. Experience has shown us that users are hidden from the GAL 
for a variety of reasons and our customers have told us that they don't want Epicenter to remove contacts just because a user is hidden.

 

Force full resync

 

You can force Epicenter Server to rewrite all contacts in all mailboxes as follows:

Select the desired task in the task list in Epicenter Server.
Go to the  menu.Task
Select .Strict Updates
Click .Send Now

Note that this will cause a full rewrite of all contacts in all mailboxes and so may take a substantial amount of time in large organizations.

Reserved properties will not be overwritten.

 

Client installation

Administrators do not typically need to preinstall the client. When you distribute an  to POP3/IMAP users, each user receives Attachment update
an  sent by Epicenter Server that includes a link for downloading and installing the client.When users follow the link, they will see a simple email
wizard that will help them install the client.

The MSI package for the client installs per-user, not per-machine. Therefore it can be installed on limited accounts without requiring administrator 
privileges. Because of this installation strategy, the software will not appear under Program Files.

For organizations that wish to install the client on their users’ computers ahead of time, the client installation package is a standard MSI file for 
Windows Installer. It can be deployed by any utility capable of deploying MSI files.

Using the Exchange MAPI Client

The Exchange MAPI Client does not support Office 365 or other Hosted Exchange services.

Epicenter Server supports using the Exchange MAPI Client instead of Microsoft Outlook. This product can be downloaded from:

http://www.microsoft.com/en-us/download/details.aspx?id=1004

Version  or later is required.6.5.8244.0

Y . If you don't reboot, you'll get the error "The .DLL file for this service is either ou must reboot after installing the Exchange MAPI Client
damaged or could not be found" when the Microsoft Outlook Setup Wizard runs.

After you install the Exchange MAPI Client and reboot, then run Epicenter Server. You'll automatically be prompted to configure your connection 
to Exchange.

After you finish configuring your profile with the Microsoft Outlook Setup Wizard, you need to set your new profile to be the default as follows:

Open the  menu in Epicenter Server.Tools
Select .Outlook Account Settings

The client is only required for users who cannot sync wirelessly. Most installations will not use the client.

http://www.microsoft.com/en-us/download/details.aspx?id=1004
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When the "Choose Profile" window opens, click the  buttons.Options
Check the box labeled .Set as default profile
Click .OK

Note that the Exchange MAPI client does not include a Control Panel applet to configure Mail. If you need to change your configuration,  use Tools
|  in Epicenter Server.Outlook Account Settings

 

Upgrade

 

Epicenter Server periodically connects to  to check for newer software versions. If a new version is available, you will be www.connectedsw.com
notified in the Log window. You can download a new version by selecting  from the Epicenter Server  menu. It is safe Check for Upgrades Help
to install newer versions on top of older versions. You do not need to uninstall first.

You must have a valid Support Subscription to use an update. To determine your expiration date and purchase the upgrade, please select Exten
 from the  menu. See  for more information.d Subscription Tools Extend Support Subscription

For sites using "Attachment" updates, the client software version is tied directly to server versions. When you upgrade Epicenter Server, your 
users will automatically be prompted to upgrade their client software when they receive their next update.

 

Extend Support Subscription

Your Epicenter Subscription gives you access to updates and to technical support. You must have a current Support Subscription to receive 
product updates. Your original purchase includes a one-year Support Subscription. After that, you will automatically receive a renewal invoice 30 
days before your Support Subscription expires.

You can go to  to see your purchase history, including support subscriptions and http://www.connectedsw.com/EpiClient/ExtendSubscription.php
additional user packs.

Subscriptions can be renewed at any time, however, subscriptions are always contiguous, so there's no advantage to delaying purchase of a 
subscription after it expires. Subscriptions are based on the purchase date of the product, not on the purchase date of the subscription. If you 
renew early, you will not “lose” any time on your subscription. If you renew late, you will have to pay for the period between the expiration of your 
subscription and the subscription renewal date.

If you have purchased additional licenses, then all of the user/support days will be totaled and will be applied across all of your purchases to 
create a single expiration date for all users. The web page above will show you your current subscription expiration.

Remove a recipient

To explicitly remove the Epicenter contacts from a user’s phone while that user's mailbox is still active, you should:

Remove that user from all tasks, either by removing the user from the Epicenter recipients list or removing the user from the Exchange 
distribution list. This will  remove the contacts from that user's mailbox.not
Use the Clean Mailboxes command in Epicenter (under the Tools menu), which will remove all Epicenter contacts from the mailbox, which 
will then sync with the smartphone.

Also see .Manage user licenses

 

Move Epicenter Server to a new computer

 

Epicenter Server can be copied to a new computer as follows.

Make sure Outlook is correctly installed and configured on the new computer, and that you have run it at least once.
Install Epicenter Server on the new computer.
Activate Epicenter Server on the new computer using the same license code as the old computer. You do not need to purchase additional 
licenses for this change.
Shut down Epicenter Server on both the old and new computers using Task / Exit.
Copy the Epicenter Server data directory from the old computer to the new computer:

C:\Users\<username>\AppData\Local\Connected Software\Epicenter Server
 
Now you can start Epicenter on the new computer. You should see the list of tasks from your old computer.

http://www.connectedsw.com
http://www.connectedsw.com/EpiClient/ExtendSubscription.php
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Uninstall

Uninstalling the Server

You can uninstall Epicenter Server using the Control Panel applet named .Programs and Features

Uninstalling the server does not remove the Epicenter Server contacts from user’s mailboxes. To remove contacts from users’ mailboxes, open 
Epicenter Server, delete all of the tasks, and choose Cleanup Mailboxes from the Task menu.

Uninstalling the server also does not remove the configuration data. To delete configuration data, you can manually remove the directory below: 
If you plan to transfer Epicenter Server to another computer, you should make a backup of the configuration data before you delete the directory.

Windows 7/8/10, Windows Server 2008/R2, 2012/R2, 2016

C:\Users\ \AppData\Local\Connected Software\Epicenter Serverusername

Uninstalling the Client

The Epicenter client can be uninstalled from the Control Panel applet named .Programs and Features

Uninstalling the client does not remove any contacts or folders created by Epicenter.

Uninstalling from Phones and Tablets

Epicenter does not install software on the phones and tablets. To remove the shared contacts from a user’s address book, remove that user from 
the Recipients list in Epicenter, then use Tools / Cleanup Mailboxes.
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Menu Options

This section provides detailed descriptions of the menu choices in Epicenter 
Server.

 

Task Settings Pages
 

Task menu
View menu
Tools menu
Help menu

   

Task menu

The Task menu provides commands for managing tasks and sending updates. The Task menu contains the following options:

New
Edit Settings
Rename
Delete
Select All
Send Now
Strict Updates
Exit

New

Only available when you are in  view. Also available by clicking New on the toolbar. The New command brings up the Configuration Tasks
property sheet, which is described under .Task Settings

Edit Settings

Only available when you are in  view. To use the Edit command, select a task and then choose click Edit on the toolbar. Tasks Task | Edit, or 
The Edit command brings up the Configuration property sheet, which is described under .Task Settings

Rename

Only available when you are in  view. To use the Rename command, select a task and then choose , or click Rename on Tasks Task | Rename  
the toolbar. The name of the task will be opened and you can edit the name.

Delete

Available in both Tasks and History views.

When you are in  view. To use the Delete command, select one or more tasks and then choose , or click Delet on the toolbar. Tasks Task | Delete  
You will be asked to confirm the deletion and then the task will be removed.

Deleting a task does NOT remove the contacts in recipients' mailboxes. To remove the contacts in the mailboxes, use  | Tools Cleanup 
.Mailboxes

Send Now

Only available when you are in  view.  tells Epicenter to run the selected task(s), even if that task isn’t scheduled. Using Tasks  Send Now Send 
 will have no impact on the next scheduled update.Now

If the address book has not been changed since the last update, you will be asked if you really want to send an update.

Select All

Only available when you are in  view.  will select all task(s). Then you can use  or  to act on all of those tasks.Tasks  Select All Send Now Delete

Strict Updates
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This command forces all contacts in all destination folders to be completely rewritten. Without this option, only contacts that have changed in the 
source folder will be updated. This option should be used sparingly because it can put a significant load on your wireless synchronization server
(s). This option will remove all changes made by users to their Epicenter contacts, except that changes to  will be kept.Reserved Properties

When  is checked, Epicenter Server will:Strict Updates

Delete all contacts in the destination folder that belong to this task but don’t exist in the source address book.
Rewrite all existing contacts to force the information to update, except for Reserved Properties.

The  |  option applies to the next update sent using . The  |  option means that this setting Strict Updates Once Send Now Strict Updates Always
will always be used. This will cause severe performance problems for large address books!

Exit

Shut down the Epicenter Server application. Scheduled tasks will continue to run even if you close Epicenter.

The Task menu provides commands for managing tasks and sending updates. The Task menu contains the following options:

New
Edit Settings
Rename
Delete
Select All
Send Now
Strict Updates
Exit

New

Only available when you are in  view. Also available by clicking New on the toolbar. The New command brings up the Configuration Tasks
property sheet, which is described under .Task Settings

Edit Settings

Only available when you are in  view. To use the Edit command, select a task and then choose click Edit on the toolbar. Tasks Task | Edit, or 
The Edit command brings up the Configuration property sheet, which is described under .Task Settings

Rename

Only available when you are in  view. To use the Rename command, select a task and then choose , or click Rename on Tasks Task | Rename  
the toolbar. The name of the task will be opened and you can edit the name.

Delete

Available in both Tasks and History views.

When you are in  view. To use the Delete command, select one or more tasks and then choose , or click Delet on the toolbar. Tasks Task | Delete  
You will be asked to confirm the deletion and then the task will be removed.

Deleting a task does NOT remove the contacts in recipients' mailboxes. To remove the contacts in the mailboxes, use  | Tools Cleanup 
.Mailboxes

Send Now

Only available when you are in  view.  tells Epicenter to run the selected task(s), even if that task isn’t scheduled. Using Tasks  Send Now Send 
 will have no impact on the next scheduled update.Now

If the address book has not been changed since the last update, you will be asked if you really want to send an update.

Select All

Only available when you are in  view.  will select all task(s). Then you can use  or  to act on all of those tasks.Tasks  Select All Send Now Delete

Strict Updates

This command forces all contacts in all destination folders to be completely rewritten. Without this option, only contacts that have changed in the 
source folder will be updated. This option should be used sparingly because it can put a significant load on your wireless synchronization server
(s). This option will remove all changes made by users to their Epicenter contacts, except that changes to  will be kept.Reserved Properties
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The Strict Updates option applies to the next “Mailboxes” update sent using Send Now. When  is checked, Epicenter Server will:Strict Updates

Delete all contacts in the destination folder that belong to this task but don’t exist in the source address book.
Rewrite all existing contacts to force the information to update, except for Reserved Properties.

Exit

Shut down the Epicenter Server application. Scheduled tasks will continue to run even if you close Epicenter.

View menu

 

The View menu provides commands for selecting the information you see and for configuring the user interface. The View menu contains the 
following options:

Tasks
History
Refresh
Toolbars and Docking Windows
Status Bar 

Tasks

Selecting the  command from the View menu will show you the list of tasks in the system and will show the log of recent activity. Tasks

History

Selecting the  command from the View menu will show you the history of each task that was executed. Select any task in the list to get History
the details of that task execution. You can delete old entries in the history by selecting the entries in the top list and clicking  on the toolbar.Delete

Refresh

Reload the summary information in either the Tasks view or the History view. Normally this information automatically updates and using Refresh 
is not necessary.

Toolbars and Docking Windows

The  command will allow you to:Toolbars and Docking Windows

Turn the toolbar on or off.
Modify the commands in the menus.
Modify the commands in the toolbar.
Modify keyboard shortcuts.
Change the size of icons in the toolbar.

Status Bar

Turns the status bar on or off at the bottom of the window.

 

Tools menu

 

The Tools menu provides rarely-used utility commands. The Tools menu contains the following options:

Cleanup Mailboxes
Reserve User Properties
Exchange Privileges
Outlook Account Settings

Cleanup Mailboxes
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This command is used to remove contacts and folders from mailboxes that are no longer being managed by Epicenter Server. Epicenter keeps a 
history of each folder in each mailbox that is updated. If you remove recipients from tasks, rename destination folders, or delete tasks,  you can 
have orphan contacts left in the users’ mailboxes. This command will remove those contacts.

For more information, see .Remove Epicenter contacts from mailbox(es)

Reserve User Properties

This command allows you to choose fields in Outlook that will be reserved for each end-user when Epicenter updates contacts. End-users can 
put data into these fields in Outlook, OWA or their phones and Epicenter will not overwrite or delete that data.

The checkbox at the bottom of this dialog allows you to decide what happens when Epicenter needs to delete a contact that contains data 
entered by the end-user.

This menu option only applies to Mailbox or Public Folder updates. This menu option is ignored for Attachment updates. 

For more information, see .Reserve User Properties

Exchange Privileges

After installing Epicenter Server, you sometimes need to adjust the permissions that Epicenter Server attempts to use to open mailboxes in 
Exchange depending on whether you are using Receive-As or Full Access.

Outlook Account Settings

This choice is convenient shortcut to “E-mail Accounts” normally found under  | .Control Panel Mail

 

Help menu

 

The Help menu provides commands for viewing this manual, managing subscriptions and licenses, and viewing version and copyright information 
about Epicenter Server. The Help menu contains the following options:

View Manual
Manage Licensed Users
Extend Subscription
Sync License
Change License Code
Check for Upgrade
About Epicenter Server

View Manual

Displays this manual in your browser.

Manage Licensed Users

Epicenter Server tracks which users are licensed to receive updates. Users will automatically be added to this list if licenses are available and 
users will (usually) be automatically disabled if their Exchange mailbox is deleted.

Each recipient in this window has one of three icons:

Green checkmark - user is licensed
Bar on red background - user is disabled
No icon - user is unlicensed.

A user who appears in multiple tasks requires only a single license.

If you want to manually remove licenses, or you want to view the list of licensed users, use Manage Licensed Users.

Once a user is licensed, that mailbox is licensed until that user leaves the company. Therefore, removing a user from all tasks does not remove 
the license. Once you click the Disable button, there is no way to reenable the license.

The  button attempts to resolve the mailbox for each user in the list. All users who no longer have a mailbox will be disabled and their Validate All
licenses can be reused.

Extend Subscription

Opens a web page in your browser that allows you view your purchase history and purchase subscription renewals.
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Your Epicenter Support Subscription gives you access to updates and to technical support. Your initial purchase of Epicenter includes a one-year 
Subscription. Use this menu to renew your subscription.

Subscriptions can be renewed at any time. Subscriptions are always contiguous and are based on the purchase date of the product, not on the 
purchase date of the subscription. If you renew early, you will not “lose” any time on your subscription. If you renew late, you will have to pay for 
the period between the expiration of your subscription and the subscription renewal date.

Sync License

If you have purchased additional users, use this command to update the local copy of the license to reflect what you have purchased. You do not 
need to do this after you extend your subscription.

Change License Code

Allows you to enter a new license code. This command is only needed if you have received a completely new license code, which rarely 
happens. Most people should use Sync License instead.

This command shuts closes Epicenter Server and restarts by opening the Registration window. After the Registration window closes, you will 
need to manually restart Epicenter Server..

Check for Upgrade

Instructs Epicenter to check with Connected Software to see if a new version available. You must have a current Subscription to install upgrades. 
Versions that were released after your subscription expired will be marked with a red warning.

If any updates are available, you will be shown a window that lists the available updates and describes what’s was new in each update.

About Epicenter Server…

The About menu choice will show you information about what version of Epicenter Server you are running, including the Build number.
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History of Changes

The history of new features and bug fixes in Epicenter Server can be found at .https://www.connectedsw.com/WhatsNew/57261

https://www.connectedsw.com/WhatsNew/57261
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FAQ

Features

Does Epicenter run as a service?

Epicenter runs updates under the Windows Task Scheduler, which is itself a service. Once you’ve defined the update schedule for a task in 
Epicenter, you can close Epicenter and log out and updates will still be distributed.

Does Epicenter support Office 365 and other Hosted Exchange services?

Yes, definitely. See the section on .Hosted Exchange

Capabilities

Can I distribute contacts kept in Public Folders?

Yes, just choose Public Folders as the source address book.

Can I distribute contacts kept in SharePoint?

Yes. See .Send a SharePoint list

Do I have to stay logged in for Epicenter to work?

Epicenter runs updates under the Windows Task Scheduler, which is itself a service. Once you’ve defined the update schedule for a task in 
Epicenter, you can close Epicenter and log out and updates will still be distributed.

Installation

Why can’t I install Epicenter Server on my Exchange Server or BlackBerry Enterprise Server?

Epicenter Server has not been certified to run on the same installation of Windows as Exchange or BES. There is a high likelihood that they will 
either interfere with or corrupt each other.

However, Epicenter Server has minimal system requirements and will run quite happy on a Hyper-V or VMware virtual machine, even on the 
same hardware as Exchange Server or BES.

Licensing

Does my Epicenter Server license expire?

Your license does not expire, but you must have an active subscription to download the latest updates. You can purchase an update by opening 
the Help menu in Epicenter and selecting Extend Subscription.

Does my license include free updates?

To receive updates to Epicenter Server, you must have a current Support Subscription. Your original purchase includes a one-year Support 
Subscription. After that, you can purchase extensions at http://www.connectedsw.com/EpiClient/ExtendSubscription.php

Subscriptions are always contiguous, so there's no advantage to delaying purchase of a subscription after it expires.

Synchronization

Do contacts sync in both directions?

No. Changes made by users do not sync back to the GAL.

Can users make changes to contacts distributed by Epicenter?

Users can change designated fields in their personal copy of each contact if you use . These changes do not sync back Reserve User Properties
to Epicenter's source address book.

Where does Epicenter put the contacts?

Epicenter puts contacts into whatever folder name you choose. This folder will be created in Outlook underneath the default Contacts folder. You 
can also put the contacts in the default Contacts folder, but this is strongly discouraged unless you have Windows Mobile users because it can be 
confusing to end users.

Are existing contact overwritten?

http://www.connectedsw.com/EpiClient/ExtendSubscription.php
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Epicenter will "take over" any contacts in the destination folder that match contacts in the source address book (such as the GAL.) These 
matching contacts will be completely overwritten, except for fields marked in . Conversely, contacts that don't match a Reserve User Properties
contact in the source address book will be completely ignored.

This behavior only happens on the initial update. If a user later created a new contact that matched an entry in the GAL, then that contact would 
be ignored.

What if a user deletes a contact managed by Epicenter?

That contact will be automatically recreated the next time Epicenter distributes an update.

I just installed Epicenter and sent an update. Why don’t I see anything on my phone?

See .Contacts won't synchronize

How do I troubleshoot synchronization problems with phones?

If the contacts are appearing in each user’s contacts folder, then Epicenter is doing its job. All phone synchronization is handled by BES or 
ActiveSync. Epicenter does not communicate directly with the smartphones at any time.

Public Folder Synchronization

Why doesn't Outlook show the Business 2 phone number in an Epicenter folder when I put something in the Business 2 field in the 
Public Folder?

Epicenter does not change the default phone labels in Outlook, even if some of them are empty. So this behavior is expected.

Separate Address Books

Can I put the contacts show in different address books on the phones?

No. Although the contacts may show in Outlook in a different folder, the phones and tablets only have a single address book and so everything is 
merged together. Epicenter assigns a category to all contacts that it distributes.

More information:

BlackBerry address book - use the Filter command to display contacts from particular categories.

iOS - you can turn on or off the display off contacts from particular folders.

Android - devices running Android prior to 4.2.2 cannot sync subfolders.
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Troubleshooting and Technical Support

Technical Support Options

Please visit our web site at  to access our Knowledge http://www.connectedsw.com/support/index.php?/Knowledgebase/List/Index/4/epicenter
Base or submit a trouble ticket.

If you report a problem, please include:

The specific error message, if any.
The version of Outlook.
The version of Exchange.
Whether the problem is with the server or the client.
The version of Windows.

Troubleshooting

This section includes common troubleshooting problems, broken into categories below.

Troubleshooting
 

Contacts won't synchronize
Android issues
Outlook issues
Windows Task Scheduler issues
Hosted Exchange

   

 

 

Contacts won't synchronize

Epicenter Contacts are not showing on the phones

This is a common problem due to additional configuration requirements for your installation. Please perform these three steps, in order, to resolve 
the problem.

Make sure the appropriate folder has been enabled to appear on the device. On an iPhone, click Groups in the top left of the Contacts app.
If this is a new installation, make sure you wait long enough. Sometimes the first synchronization can take thirty minutes or more.
If you are on iPhone/iPad, make sure Push is turned on in  |  | . If the contacts still won't sync, try Settings Accounts Fetch New Data
forcing the contacts to sync, as follows:

Go to  | .Settings Accounts
Open your Exchange ActiveSync account.
Turn Contacts off.
Turn Contacts on again.
Check your Contacts.

If you are sending contacts to the default Contacts folder, the contact may be filed differently than you expect. Look up the contact on the 
phone by both first name and last name. Ordering may be different on the phone than it is on Exchange.

If contacts still don't appear, then narrow down the problem by performing the following steps:

Go to the computer for one of the people who receives updates from Epicenter.
Start Outlook.
Go to the folder that Epicenter created in the mailbox of one of the recipients, or to the default Contacts folder if you are distributing to the 
default contacts folder.
Manually create a new contact in that folder in Outlook.
Wait for the phone to sync the contact (or not.)

This process tests if the folder is syncing, independent of Epicenter Server. If your new contact does not sync, then it’s a problem unrelated to 
Epicenter. 

If your new contact does sync, then it’s a problem with Epicenter Server. Please visit our support site at   http://www.connectedsw.com/support/
and submit a support ticket.

http://www.connectedsw.com/support/index.php?/Knowledgebase/List/Index/4/epicenter
http://www.connectedsw.com/support/
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Epicenter does not overwrite contacts that users change

Administrators often expect that changes made by users to Epicenter contacts will be overwritten the next time Epicenter runs. In practice, this 
does not usually happen.

Epicenter only overwrites a contact when that contact changes on the server. Updating a contact is very expensive in terms of time, especially if 
you have Hosted Exchange. If Epicenter overwrote all contacts on every run, then it would take literally days to run for some of our larger 
customers. Conversely, if Epicenter read every contact from every mailbox to try and look for changes made by users, it would place a significant 
load on the Exchange Server.

So Epicenter does not rewrite a contact until it changes on the server.

Administrators can force a global rewrite by selecting the  option from the Task menu and clicking Send Now. This Strict Updates
allows administrators to decide when it needs to be done.

In practice, if users believe that they can successfully save these changes, this can cause significant problems due to data loss. Some advance 
warning to your users is recommended.

Some users receive partial updates

First, look in the Epicenter folder in Outlook for one of the users having the issue. See if the contact in the folder has a correct values. If it does, 
then the problem is related to ActiveSync. We've definitely seen that happen if you have "Push" disabled on the phone, especially iPhones. The 
contacts get updated on an unpredictable schedule.

You can test for this by making a change to a field in Outlook for one of the problem contacts. See if it syncs to the phone. If it doesn't, then try 
the opposite. Make a change to that field on the phone, wait for it to sync, and see if the contact in the Epicenter folder was updated.

You may also be seeing contacts on the phone that aren't controlled by Epicenter. These might have been created by the user before Epicenter 
was installed. You can test for this with the same strategy of making a change to the contact on the phone and seeing if that syncs with the 
contact in the Epicenter folder in Outlook.

Note that Outlook has its own synchronization oddities and it's often safer to review and edit the contacts with the Outlook web interface.

New contacts sync to phones but changed contacts do not

This very rare problem can happen to customers who have used Epicenter Server for several years.The solution is to wipe all Epicenter contacts 
in all mailboxes and the allow Epicenter to recreate them.

Open Epicenter Server
Edit the task
Go to the Recipients tab.
Remove all recipients (copy them to notepad for safety.)
Click OK
Go to the Tools menu and select Cleanup Mailboxes.
Select the desired folder.
Click Clean
Wait for the process to complete
Edit the recipients again and paste back in the recipients you removed earlier.
Click OK.
Click Send now to recreate all contacts.

Android issues

Epicenter contacts don't appear on Android phones

Phones based on Android prior to 4.2.2 can't sync subfolders. To sync Epicenter contacts with these older Android phones, you must set the 
Epicenter task to distribute to the default Contacts folder in Outlook.

To ensure that your Epicenter folder is set to display in the Gmail application in recent versions of Android, perform the following steps (these 
steps assume that you have already configured the Gmail application to access your Exchange account via the "Exchange" method. Your 
Epicenter contacts will not display if you use POP3 or IMAP).

Open your Contacts application on Android.
Tap the "menu" in the the top right.
Tap  .Contacts to Displays
Tap  .Customize
Tap the Exchange account.
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You should see all of the categories used in Contacts folders that appear under the default Contacts folder 
Make sure that the category you selected in Epicenter settings is shown. By default it has the same name as the folder.

There appears to be no way to configure Contacts to show or not show certain folders, only categories.

Supporting both Android and iOS Users

Important: This section applies ONLY if you must support users running Android before version 4.2.2.

If you support both iPhone/iPad users and Android devices prior to 4.2.2, it can be a challenge to decide how to distribute contacts. The older 
versions of Android can only sync contacts in the default contacts folder, but this is a poor experience for users when using Outlook. On the other 
hand, iOS supports multiple contacts folders, so segregating the contacts for those users provides a great experience in both Outlook and on the 
iPhone/iPad.

Your choices are to either:

Create a single task that distributes to the default contacts folder for everyone
Create two separate tasks, one for Android users and one for iOS users.

Most customers opt for two separate tasks because it makes their users happier. More information can be found under .Destination Folder

 

Outlook issues

 

You get MAPI_E_FAILONEPROVIDER error for each update

There are two common causes for this problem:

You must tell Epicenter Server to use different permissions using the  |  command.Tools Exchange Privileges
You must be able to start Outlook without being asked for a username/password. See .Outlook Passwords

Some Outlook users do not receive an update

This solution applies to Mailbox updates where only a few (or one) users are not receiving the update. The most common cause is that the user 
in not in the recipients list or is not in the selected distribution list.

Go to the  view in Epicenter. Select one of the successful updates for the related Task. Scroll down and look for the user. If the user does not Log
appear in the list, then you either need to add that user to on the  tab in Settings or you need to add that user to the distribution list in Recepients
Exchange.

Changes don’t appear in Outlook

Changes can sometimes take a while to synchronize with Outlook. Use Outlook Web Access to view the contacts so as to make sure that it's not 
a synchronization delay.

Folders that Epicenter Server creates in Exchange mailboxes do not show as address books

This is intentional. The contacts being distributed by Epicenter Server already exist in the GAL. Showing them as an Outlook address book would 
be redundant.

FAX numbers are showing in the Outlook address book

This is a standard feature of Outlook. Please see this knowledgebase article for possible solutions:
http://www.connectedsw.com/faq.php?faq=27

Messages aren’t being sent with POP3 updates.

Messages will not be sent by Outlook if Outlook isn't running (which means that the account must be logged in and Outlook must be left 
running.)
You must also make sure the “Send immediately” option is set:

For Outlook 2010:

1. Check this box: File > Options > Advanced > Send/Receive > Send immediately when connected.
2. And check this box: Send/Receive > Send/Receive Groups > Define Send/Receive Groups > Schedule an automatic send/receive every  nnn
minutes.

Windows Task Scheduler issues

http://www.connectedsw.com/faq.php?faq=27
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No updates are sent when run under Windows Task Scheduler

Make sure that you’ve configured the task to run as the same user who ran Epicenter.
Make sure you’ve set the user’s password.
If you are on a domain, make sure the user has Logon as a Batch Job rights and that Deny Logon as a Batch Job is set.not 
Make sure the task is enabled in Windows Task Scheduler.
Check for errors on the Output pane and the History pane in Epicenter Server.

 

Hosted Exchange

Epicenter Server uses Microsoft Outlook to communicate with Exchange. If Outlook works, then Epicenter will work. Epicenter Server does not 
require any software to be installed on the Exchange Server, so there are no issues with custom protocols, firewalls, or complicated 
configurations.

The changes required to use Epicenter Server with hosted Exchange mostly relate to administrative functionality that Hosted Exchange vendors 
do not expose to their customers.

Security Configuration

If you are using Mailbox updates, you saw that there were  for configuring security in Epicenter Server. In a Shared Hosting three techniques
environment,  will not work. The Receive-As privilege is not something that can be granted to customers because it would allow Technique 1
access to all mailboxes in all companies. Therefore, only  or  can be used in a Hosted Exchange environment.Technique 2 Technique 3

Outlook Passwords

Epicenter Server must be able to connect to the Exchange mailbox without having to enter a username and password. See  foOutlook Passwords
r more information.

Performance

The primary difference you’ll see when connecting Epicenter Server to an Exchange Server of the Internet is slower performance. Since 
Epicenter Server usually runs unattended in the middle of the night, it’s typically not an issue when Epicenter is running in production, but some 
administrators are surprised during testing and initial deployment.

Outlook is able to maintain high performance by making a local cache of the mailbox. Epicenter Server is not able to do this because of the 
volume of data. Therefore, each and every request has to be handled by the remote Exchange Server. This is particularly noticeable when 
opening mailboxes, which can take ten to twenty seconds per mailbox.

Epicenter Server is able to create from two to four contacts per second when using Hosted Exchange, even with a fast connection. Therefore, if 
you are distributing 3,000 contacts, it’s going to take at least twenty minutes per mailbox to do the initial update. Subsequent updates are 
incremental and will take only a few seconds.

 

 

If you are using a shared hosting environment such as Office 365, Rackspace Exchange Email or SherWeb, some functionality within 
Epicenter Server will require additional steps to work properly.
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  Address Book page
The Address Book tab determines which address book 
folder is distributed by Epicenter Server. For most 
formats, the default folder for that address book will 
automatically be selected if you do not click File or 
Folder. Pub.gif Other notes about the Addre

  Administrative Tasks
This section describes administrative tasks that may be 
required when using Epicenter Server.

  Android issues
Epicenter contacts don't appear on Android phones 
Phones based on Android prior to 4.2.2 can't sync 
subfolders. To sync Epicenter contacts with these older 
Android phones, you must set the Epicenter task to 
distribute to the default Contacts folder in Out

  Attachment Updates for POP3/IMAP Users
Sometimes you need to send address books to users 
who aren’t on an Exchange Server. These users may 
not be using a smartphone or they may be 
synchronizing their smartphone with a USB cable. 
Epicenter supports these users by emailing them an 
attachment tha

B C

  Change sort order on phones
If contacts aren’t sorted the way users are used to 
seeing them, you can change the way Epicenter Server 
writes the display name This won't affect the sort order 
in Outlook, but it will affect the sort order on most 
phones. Select the task in Epicenter an

  Choose a Machine
Carefully consider where you install Epicenter Server. 
Installing Epicenter in the right place now will save you 
headaches later from having to move the server. 
Epicenter is best installed on a machine or VM that is 
running all of the time. This isn't a r

  Client installation
The client is only required for users who cannot sync 
wirelessly. Most installations will not use the client. 
Administrators do not typically need to preinstall the 
client. When you distribute an Attachment update to 
POP3/IMAP users, each user receives an

  Configuration (Alternate)

  Configuration (Typical)
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Exchange Mailbox Updates The standard configuration 
for Epicenter Server is to use "Mailbox" updates, where 
the source address list is copied to a contacts folder in 
each user’s Exchange mailbox. This update method will 
work with any smartphone that supp

  Contacts won't synchronize
Epicenter Contacts are not showing on the phones This 
is a common problem due to additional configuration 
requirements for your installation. Please perform these 
three steps, in order, to resolve the problem. Make sure 
the appropriate folder has been ena

  Create a Task
Tasks in Epicenter define "who, what, where and when" 
for the contacts distributed to end-users. Tasks run 
under Windows Task Scheduler unless you disable 
automated updates. From the main window in Epicenter 
Server you can create tasks, rename tasks, dele

  Create an Exchange Mailbox
It is safest to create a dedicated mailbox for Epicenter 
Server. Epicenter will have direct access to many (or 
all) mailboxes on your Exchange Server. If you were to 
use your personal mailbox for Epicenter, then anyone 
walking up to your computer could op

  Create multiple tasks
You can create multiple tasks that run at different times, 
distribute to different recepients, and/or distribute 
different contacts. There are several good reasons to do 
this: Device segmentation: Android prior to 4.2.2 and 
Windows Mobile do not support s

  Customization
This section describes various customization tasks that 
make Epicenter Server easier to use and administer.

  Customize
Epicenter Server can be customized to meet end-user 
needs and to simplify administration. Customization

D

  Destination Folder page
The Destination Folder page selects where Epicenter 
Server creates contacts in the recipient's mailbox. 
Android (pre-4.2.2) and Windows Mobile devices will 
only synchronize with the default Outlook Contacts 
folder. Exchange Mailbox Updates If you are dist

E

  Email Customization
Creating the Email Messages End-users receive an 
email notification when they receive an address book 
update. The email provides instructions on how to 
download the Epicenter client so that they can use the 
update. The default message points to Connected

  Email page
You will only see the Email property page if this is an 
Attachment update task. This property page does not 
appear in the wizard when you initially configure the 
task. Use the Email page to change the message your 
users receive in their email. Epicenter S

  Enter the license code
After you purchase the software, you will receive your 
license code by email. You can enter it into Epicenter 
Software by going to the Help menu and selecting Enter 
License code. Epicenter Server requires an internet 
connection to contact the Connected So

  Epicenter Server
Welcome https://www.connectedsw.com/Images
/EpicenterTasks.png Epicenter Server is a software 
product http://www.connectedsw.com/Overview/57261 
for Microsoft Windows from Connected Software 
http://www.connectedsw.com/ that allows Exchange 
administrators to

  Extend Support Subscription

https://connectedsw.atlassian.net/wiki/spaces/epicenter/overview
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Your Epicenter Subscription gives you access to 
updates and to technical support. You must have a 
current Support Subscription to receive product 
updates. Your original purchase includes a one-year 
Support Subscription. After that, you will automatically

F

  FAQ
Features Does Epicenter run as a service? Epicenter 
runs updates under the Windows Task Scheduler, 
which is itself a service. Once you’ve defined the 
update schedule for a task in Epicenter, you can close 
Epicenter and log out and updates will still be di

  Force full resync
You can force Epicenter Server to rewrite all contacts 
in all mailboxes as follows: Select the desired task in 
the task list in Epicenter Server. Go to the Task menu. 
Select Strict Updates. Click Send Now. Note that this 
will cause a full rewrite of all c

G

H

  Handle terminated employees
When employees leave the company, you often don't 
want them to take a copy of your address book with 
them. A common question is whether Epicenter 
automatically removes the contacts when their 
Exchange account is removed. The answer is no, 
because Epicente

  Help menu
The Help menu provides commands for viewing this 
manual, managing subscriptions and licenses, and 
viewing version and copyright information about 
Epicenter Server. The Help menu contains the 
following options: View Manual Manage Licensed 
Users Extend Subs

  History of Changes
The history of new features and bug fixes in Epicenter 
Server can be found at https://www.connectedsw.com
/WhatsNew/57261 https://www.connectedsw.com
/WhatsNew/57261.

  Hosted Exchange
If you are using a shared hosting environment such as 
Office 365, Rackspace Exchange Email or SherWeb, 
some functionality within Epicenter Server will require 
additional steps to work properly. Epicenter Server 
uses Microsoft Outlook to communicate with E

I

  Install Epicenter Server
Install and Run Outlook Log in to the account you 
created earlier and perform the following steps: Install 
Outlook 32-bit. For information about 64-bit Outlook 
support, see Using 64-bit Outlook. Install the latest 
Outlook service pack. Create a profile fo

  Installation

J K

L

  Label Index

M

  Manage recipients using Active Directory
Most organizations running Epicenter Server will want 
to manage recipients using a Distribution List instead of 
manually entering recipients into the Epicenter Server 
properties page. With this strategy, Epicenter will 
automatically pick up new employees

  Manage user licenses
Licenses in Epicenter Server are based on the number 
of mailboxes. A mailbox will only be counted once, even 
if it appears in multiple tasks. If you distribute to an 
Exchange distribution list, each recipient mailbox will be 
assigned a separate license. L

  Menu Options
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This section provides detailed descriptions of the menu 
choices in Epicenter Server.

  Mirror Folder page
You will only see the Mirror Folder page if this is an 
Attachment update task. This property page does not 
appear in the wizard when you initially configure the 
task. The Mirror Folder is where Epicenter Server writes 
a copy of the address book. This is f

  Move Epicenter Server to a new computer
Epicenter Server can be copied to a new computer as 
follows. Make sure Outlook is correctly installed and 
configured on the new computer, and that you have run 
it at least once. Install Epicenter Server on the new 
computer. Activate Epicenter Server on th

N O

  Outlook issues
You get MAPI_E_FAILONEPROVIDER error for each 
update There are two common causes for this problem: 
You must tell Epicenter Server to use different 
permissions using the Tools | Exchange Privileges 
command. You must be able to start Outlook without 
being a

  Outlook Passwords
Microsoft Outlook must be configured to access 
Microsoft Exchange without typing in your username 
and password. The reason this matters is that Epicenter 
Server runs unattended under Task Scheduler, so it 
must be able to start Outlook without prompting fo

P

  Page Index

  Product Description
Epicenter Server allows organizations to update iPhone
/iPad, Android, and Windows Mobile users with a copy 
of the corporate address list or any other list of 
contacts. Epicenter solves the problem of smartphones 
that can't sync with a public address book.

  Public Folder updates
This update method is only useful for BlackBerry 
devices connected to BES 5. Epicenter Server 
supports sending updates to an Exchange Public 
Folder, which BES 5 is able to distribute to all 
BlackBerry users. This strategy has two advantages: 
Epicenter Ser

Q

  Quick Start
The section describes what you absolutely must do to 
configure Epicenter Server to distribute updates to 
users' mailboxes in Exchange. If you read nothing else, 
read this page. Configure Exchange 1. Create a 
Mailbox It is safest to give Epicenter Server i

R

  Recipients page
The Recipients page selects who should receive 
updates from Epicenter Server based on the schedule 
you chose in the Schedule tab. You will not see this 
tab if you selected "Update an Exchange Public Folder 
automatically" for the update method. Pub.gif Ins

  Remove a recipient
To explicitly remove the Epicenter contacts from a user’
s phone while that user's mailbox is still active, you 
should: Remove that user from all tasks, either by 
removing the user from the Epicenter recipients list or 
removing the user from the Exchange d

  Remove Epicenter contacts from mailbox(es)
It's often necessary to "clean" a mailbox and remove 
any contacts and/or folders managed by an Epicenter 
task. You can do this with the Tools | Cleanup 

S

  Schedule page
The Schedule tab determines how often Epicenter 
Server processes updates. For Mailbox and Public 
Folders updates, each time an update is run, all 
destination folders are individually synchronized. Pub.gif 
Attachment updates: an update email is only sent i

  Scripting
Epicenter Server supports using VBScript to modify the 
contacts before they are distributed. Common uses for 
this function include: Removing properties Moving 
properties to a different field Selecting contacts by 
content(especially on Hosted Exchange wher

  Send a SharePoint list
Epicenter Server can distribute a Sharepoint contact list 
by syncing Outlook to the SharePoint contacts list and 
then selecting that folder in Outlook as the source 
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Mailboxes command. Epicenter keeps a history of 
each folder in each mailbox that is updated. If you rem

  Reserve User Properties
This section only applies to Mailbox or Public Folder 
updates and is ignored for Attachment updates. 
Reserved Properties allow you to designate fields that 
Epicenter Server will never overwrite. Users can safely 
put information into these fields and that

  Run as a Windows Service
Epicenter runs updates under the Windows Task 
Scheduler, which is itself a service. Once you’ve 
defined the update schedule for a task in Epicenter, 
you can safely close Epicenter and log out and 
updates will still be distributed.

address book. Outlook must be left open for this to 
work. For information on configuring O

  Send a subset of the GAL
You can distribute the contacts from any Address List, 
not just the Global Address List. For example, many 
Exchange Server accounts have a default Address List 
named "All Users", which does not include contacts, 
distribution lists or resources. You can se

  Send distribution lists
This section is about how to send distribution lists so 
that the distribution lists appear on the smartphone. If 
you want to send your updates to a distribution list, 
please see Send to Exchange distribution list. Most 
smartphones do not support having di

  Send the Update
You are now ready to send the update. Although the 
default schedule is early each morning, you can send 
the update immediately be clicking the Send Now 
button on the toolbar. Depending on the number of 
recipients and the number of contacts being distribut

  Send to Exchange distribution list
This section is about how to select who receives 
updates from Epicenter using a distribution list. If you 
want to send distribution lists so that the distribution lists 
appear on the smartphone, please see Send distribution 
lists. The recommended configur

  Set Mailbox Permissions
The steps below are only necessary if you will be 
distributing contacts to each user's Exchange mailbox. 
This is the most common configuration. In order to 
update mailboxes, Epicenter Server requires permission 
to access all Exchange mailboxes that will

  System Requirements
Server Requirements Epicenter Server runs on a client 
workstation, not on the Exchange Server. Epicenter 
Server is typically run in a VM and has a minimal impact 
on system resources. The system requirements for 
Epicenter Server are as follows: Microsoft W

T

  Task menu
The Task menu provides commands for managing 
tasks and sending updates. The Task menu contains 
the following options: New Edit Settings Rename 
Delete Select All Send Now Strict Updates Exit New 
Only available when you are in Tasks view. Also 
available by

  Task Settings
This section provides detailed descriptions of each of 
the property pages in the Task Settings.

  Technique 1: Receive-As privilege
Using the Receive-As privilege is only suitable for a 
dedicated Exchange Server environment. This 
technique is the easiest to configure, but requires 
administrative access to the Exchange Server. See 
Technique 2: Full Access privilege if you use a Hosted

  Technique 2: Full Access privilege
This page describes how to connect Epicenter to 
mailboxes from other users when using Microsoft 365 
or other Hosted Exchange providers. The exact steps 
are documented below. Microsoft 365 (formerly Office 
365) Using Epicenter Server with Microsoft 365 has

  Technique 3: Folder permissions

U

  Uninstall
Uninstalling the Server You can uninstall Epicenter 
Server using the Control Panel applet named Programs 
and Features. Uninstalling the server does not remove 
the Epicenter Server contacts from user’s mailboxes. To 
remove contacts from users’ mailboxes, o

  Update Method page
The Update Method page to determine the type of a 
task. This page only appears when you are creating a 
task. Once you click Finish in the task creation wizard, 
the update method cannot be changed. Most sites will 
use Update Exchange mailboxes automaticall

  Upgrade
Epicenter Server periodically connects to www.
connectedsw.com http://www.connectedsw.com to 
check for newer software versions. If a new version is 
available, you will be notified in the Log window. You 
can download a new version by selecting Check for Upg

  Using 64-bit Outlook
Epicenter Server provides support for 64-bit Outlook as 
of Build 424. You can ask Technical Support for the 
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Folder Permissions give Epicenter Server access to 
specific folders. Unlike the other techniques, it is 
configured by the end users, not be the administrator, 
and so is useful in environments where no 
administrative access is available for Technique 2 or

  Test Mailbox Access
The steps below MUST work properly before Epicenter 
Server will be able to send updates using the Mailbox 
method. To determine whether the user in the current 
Outlook profile has sufficient permissions to update a 
particular user’s contacts, you must be a

  Tools menu
The Tools menu provides rarely-used utility 
commands. The Tools menu contains the following 
options: Cleanup Mailboxes Reserve User Properties 
Exchange Privileges Outlook Account Settings 
Cleanup Mailboxes This command is used to remove 
contacts and folde

  Troubleshooting and Technical Support
Technical Support Options Please visit our web site at 
http://www.connectedsw.com/support/index.php?
/Knowledgebase/List/Index/4/epicenter http://www.
connectedsw.com/support/index.php?/Knowledgebase
/List/Index/4/epicenter to access our Knowledge Base 
or su

download link. However, there are good reasons not to 
run it. The most commonly cited reasons for running 
Outlook 64-bit are speed and compatibilit

  Using the Exchange MAPI Client
The Exchange MAPI Client does not support Office 365 
or other Hosted Exchange services. Epicenter Server 
supports using the Exchange MAPI Client instead of 
Microsoft Outlook. This product can be downloaded 
from: http://www.microsoft.com/en-us/download/det

V

  View History
Epicenter Server keeps a history of all updates that are 
distributed. To view the history, click the History button 
on the left-hand size of the Epicenter Server window. 
The first line shows how many contacts were read 
from the source address book. The fo

  View menu
The View menu provides commands for selecting the 
information you see and for configuring the user 
interface. The View menu contains the following 
options: Tasks History Refresh Toolbars and Docking 
Windows Status Bar Tasks Selecting the Tasks 
command fr

W

  Windows Task Scheduler issues
No updates are sent when run under Windows Task 
Scheduler Make sure that you’ve configured the task to 
run as the same user who ran Epicenter. Make sure you’
ve set the user’s password. If you are on a domain, 
make sure the user has Logon as a Batch Job ri

X Y

Z !@#$
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android
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client
client-requirements

D-H

distribution-lists
epicenter
exchange-permissions
exchange-server
faq
folder-permissions
full-access
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global-address-list
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hosted-exchange

I-O

installation
ipad
iphone
license-code
never-delete
office-365
outlook
outlook-2010
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P-R

passwords
permissions
private-folder-synchronization
profiles
public-folders
receive-as-privilege
recipients
requirements
reserve-user-properties
resync

S

scripts
send-now
server-requirements
sharepoint
sherweb
sorting-contacts
strict-updates
subscription
sync-license

T-Z

tasks
task-scheduler
troubleshooting
upgrades
windows-mobile
windows-task-scheduler

0-9

64-bit
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